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หลักการออกแบบเกม (Game Design Principles) 
 การออกแบบเกมเป็นกระบวนการสร้างสรรค์ที่รวมเอาหลักการเชิงวิศวกรรม ศิลปะ และจิตวิทยาเข้า
ด้วยกัน เพื่อให้ได้เกมที่มีความสนุก เพลิดเพลิน และดึงดูดผู้เล่น กระบวนการออกแบบเกมสามารถแบ่ง
ออกเป็นหลักการสำคัญดังต่อไปนี้ 
1. การออกแบบระบบเกม (Game System Design) 
 การกำหนดกฎเกณฑ์และกลไกของเกม ซึ่งเป็นหัวใจหลักของการเล่นเกม องค์ประกอบหลัก ได้แก่ 

1. Game Mechanics – กฎที่กำหนดการโต้ตอบระหว่างผู้เล่นและเกม เช่น การเคลื่อนที่ การต่อสู้ 
ระบบพลังชีวิต 
2. Game Dynamics – วิธีที่ผู้เล่นตอบสนองและมีปฏิสัมพันธ์กับ Mechanics เช่น ระบบความ
คืบหน้า, ระบบพฤติกรรม AI 
3. Game Balance – การปรับความยาก-ง่าย, ความแข็งแกร่งของตัวละคร, ความสมดุลของไอเท็ม 

ตัวอย่าง 
1. ระบบ "Stamina" ใน Dark Souls ที่ทำให้การต่อสู้ต้องคิดก่อนโจมตี 
2. การออกแบบ "Gacha System" ใน Genshin Impact ให้ผู้เล่นมีโอกาสได้รับตัวละครหรืออาวุธ 

2. การออกแบบเกมเพลย์ (Gameplay Design) 
 การกำหนด ประสบการณ์การเล่น ให้ผู้เล่นรู้สึกสนุกและมีแรงจูงใจ องค์ประกอบหลัก ได้แก่ 

1. Core Gameplay Loop – ลูปการเล่นหลัก เช่น ยิง → ได้แต้ม → ปลดล็อกปืนใหม่ 
2. Player Progression – การพัฒนาตัวละคร เช่น อัปเลเวล, ปลดล็อกสกิล 
3. Interaction & Feedback – การให้ข้อมูลย้อนกลับแก่ผู้เล่น เช่น เสียง, แอนิเมชัน, UI 

ตัวอย่าง 
1. Super Mario ใช้การกระโดดเป็น Core Gameplay Loop 
2. The Witcher 3 มีระบบเลือกบทสนทนา ที่ส่งผลต่อเนื้อเรื่อง 

3. การออกแบบเนื้อเรื่องและโลกของเกม (Narrative & World Design) 
 การสร้างเนื้อเรื่องและจักรวาลของเกมเพ่ือให้ผู้เล่นดื่มด่ำ องค์ประกอบหลัก ได้แก่ 

1. Lore & Worldbuilding – การออกแบบโลกของเกมให้มีความลึก 
2. Storytelling Techniques – การเล่าเรื่องผ่านฉาก, บทสนทนา หรือเอกสารในเกม 
3. Character Development – การออกแบบตัวละครให้มีมิติและมีพัฒนาการ 

ตัวอย่าง 
1. The Last of Us มีเนื้อเรื่องที่ดึงอารมณ ์
2. Dark Souls ใช้ “Environmental Storytelling” เล่าเรื่องผ่านฉาก 

4. การออกแบบระดับและฉาก (Level Design) 
 การออกแบบแผนที่ ด่าน และพ้ืนที่ของเกมให้เหมาะสม องค์ประกอบหลัก ได้แก่ 

1. Map Layout – โครงสร้างของด่าน เช่น เปิดกว้างหรือเป็นทางเดินแคบ 
2. Player Guidance – การใช้แสง สี หรือองค์ประกอบอื่นเพ่ือบอกทางแก่ผู้เล่น 
3. Pacing & Challenge – การเพ่ิมความยากในแต่ละระดับ 

ตัวอย่าง 
1. Portal มีการออกแบบฉากท่ีให้ผู้เล่นเรียนรู้กลไกผ่านการเล่น 
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2. Resident Evil ใช้แสงและเงาเพ่ือสร้างบรรยากาศหลอน 
5. การออกแบบภาพและเสียง (Visual & Audio Design) 
 การสร้างสุนทรียศาสตร์ของเกมเพ่ือเพ่ิมอรรถรส องค์ประกอบหลัก ได้แก่ 
 1. Art Style – เลือกสไตล์กราฟิก เช่น Pixel Art, Realistic, Cel-Shading 

2. Animation & Effects – การเคลื่อนไหวของตัวละครและเอฟเฟกต์พิเศษ 
3. Sound Design – เสียงพ้ืนหลัง, เสียงเอฟเฟกต์ และดนตรีประกอบ 

ตัวอย่าง 
1. Hollow Knight ใช้โทนสีเข้มและเสียงดนตรีเพื่อสร้างบรรยากาศ 
2. DOOM (2016) ใช้เสียง Heavy Metal เพ่ิมความดุเดือด 

6. การออกแบบประสบการณ์ผู้ใช้ (UI/UX Design) 
 การออกแบบเมนู อินเตอร์เฟซ และประสบการณ์การใช้งาน องค์ประกอบหลัก ได้แก่ 

1. HUD (Head-Up Display) – แสดงค่าพลังชีวิต กระสุน แผนที่ 
2. Menu Navigation – ออกแบบเมนูให้ใช้งานง่าย 
3. Accessibility Features – ฟีเจอร์ช่วยเหลือ เช่น ขยายตัวอักษร หรือปรับสีสำหรับคนตาบอดสี 

ตัวอย่าง 
1. God of War (2018) ใช้ UI ที่เรียบง่าย แต่ให้ข้อมูลที่ชัดเจน 
2. The Last of Us Part II มี Accessibility Mode สำหรับผู้เล่นที่มีความบกพร่องทางสายตา 

7. การออกแบบระบบเศรษฐศาสตร์และรางวัลในเกม (Game Economy & Reward System) 
 การออกแบบระบบเงินในเกมและรางวัลเพ่ือกระตุ้นให้ผู้เล่นเล่นต่อ องค์ประกอบหลัก ได้แก่ 
 1. In-game Currency – เงินในเกม เช่น Gold, Gems 

2. Reward System – ระบบปลดล็อกไอเท็ม, โบนัส, Trophy 
3. Monetization – ระบบซื้อของในเกม เช่น Microtransactions 

ตัวอย่าง 
1. Fortnite ใช้ Battle Pass เป็นโมเดลเศรษฐศาสตร์ 
2. Genshin Impact ใช้กาชาเพื่อให้ผู้เล่นสุ่มตัวละคร 

8. การออกแบบปฏิสัมพันธ์ระหว่างผู้เล่น (Multiplayer & Social Design) 
 การออกแบบระบบให้ผู้เล่นสามารถเล่นร่วมกันหรือแข่งขันกัน องค์ประกอบหลัก ได้แก่ 
 PvP (Player vs. Player) – โหมดต่อสู้ระหว่างผู้เล่น 

Co-op & Teamplay – การเล่นร่วมกัน เช่น เกม MMO หรือ Co-op Shooter 
Social Features – การออกแบบระบบแชท, ปาร์ตี้, กิลด ์

ตัวอย่าง 
1. Among Us ใช้ระบบ Multiplayer และ Social Interaction 
2. League of Legends มีระบบจัดอันดับและการแข่งขัน 

9. การออกแบบระบบ AI และพฤติกรรมของศัตรู (AI & Enemy Design) 
 การออกแบบปัญญาประดิษฐ์ให้ศัตรูมีพฤติกรรมที่น่าสนใจ องค์ประกอบหลัก ได้แก่ 
 1. Finite State Machine (FSM) – ระบบ AI พ้ืนฐาน เช่น เดิน, โจมตี, หน ี

2. Pathfinding Algorithms – ระบบค้นหาเส้นทาง เช่น A* Algorithm 
3. Adaptive AI – AI ที่สามารถเรียนรู้พฤติกรรมผู้เล่น 
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ตัวอย่าง 
1. Alien: Isolation มี AI ศัตรูที่เรียนรู้การเล่นของผู้เล่น 
2. The Last of Us มี AI ศัตรูที่ทำงานร่วมกันเพื่อไล่ล่าผู้เล่น 
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ประเภทของเกม (Game Genre) 
 การแบ่งประเภทเกม (Game Genre) คือการจำแนกเกมตามรูปแบบการเล่น (Gameplay 
Mechanics) และโครงสร้างของเกม เกมหนึ่งเกมอาจอยู่ในหลายประเภทได้ขึ้นอยู่กับองค์ประกอบของเกมนั้น 
ๆ 
 1. Action (เกมแอ็กชัน) เกมที่เน้น การตอบสนองที่รวดเร็ว และต้องใช้ทักษะของผู้เล่นเป็นหลัก เช่น 
การต่อสู้ การกระโดด หรือการยิง 
 2. Adventure (เกมผจญภัย) เกมที่เน้นการ สำรวจโลก ค้นหาเบาะแส และแก้ปริศนา อาจมีเนื้อเรื่อง
เข้มข้น 
 3. RPG (Role-Playing Game) เกมที่ผู้เล่นรับบทเป็นตัวละคร พัฒนาสกิล เก็บเลเวล และทำภารกิจ 
 4. Shooter (เกมยิง) เกมที่เน้นการ ยิงศัตรูเป็นหลัก โดยแบ่งออกเป็นมุมมองบุคคลที่หนึ่ง(FPS) และ
สาม(TPS) 
 5. Racing (เกมแข่งรถ) เกมที่เน้น การแข่งขันความเร็ว 
 6. Puzzle (เกมปริศนา) เกมที่เน้น การใช้ตรรกะและการแก้ปริศนา 
 7. Simulation (เกมจำลองสถานการณ์) เกมที่จำลองเหตุการณ์ในโลกความเป็นจริง 
 8. Strategy (เกมวางแผน) เกมที่เน้น การวางกลยุทธ์และการคิดวิเคราะห์ 
 9. Stealth (เกมลอบเร้น) เกมที่เน้น การซ่อนตัวและลอบสังหารศัตรู 
 10. Party & Casual Games เกมที่ออกแบบมาเพ่ือความสนุกง่าย ๆ หรือเล่นกับเพ่ือน 
 11. Visual Novel วิชวลโนเวล : เป็นเกมที่ดำเนินเกมที่เด่นไปด้านเรื่องภาพ มีจุดเด่นที่กราฟิก ซ่ึง
มักจะเป็นภาพแบบการ์ตูนญี่ปุ่น เนื้อหาของเกมเป็นแบบอินเตอแรกทีฟ คือเป็นการดำเนินเรื่องโต้ตอบกับตัว
ละครต่าง ๆภายในเกมเป็นฉากๆ 

 การแบ่งประเภทเกมใน Steam  https://store.steampowered.com/ 
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คำศัพท์ที่ควรรู้ก่อนเริ่มพัฒนาเกม 
1. Platform แฟลตฟอร์ม  แฟลตฟอร์มในที่นี้หมายถึงพื้นที่สำหรับยืนของตัวละครของเกมแบบ Platformer 
ซึ่งตัวละครจะไม่สามารถทะลุผ่านได้  

 
2. Asset แอสเซต คือทรัพยากรหรือวัตถุดิบต่าง ๆ ที่ใช้ในการพัฒนาเกม เช่นกราฟฟิกต่างๆ / เสียง แอนิเมชัน  

 
 

3. Object ออปเจกต์ เป็นองค์ประกอบที่มีอยู่ในโลกของเกม อาจเป็นได้ทั้งตัวละคร สิ่งของ หรือสิ่งแวดล้อมที่
ผู้เล่นสามารถโต้ตอบได้ 

 
ถ้าเป็นแค่ภาพ ก็คือ asset แต่เมื่อไหร่ทีนำเข้ามาในเกม จะเป็น object  
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วันทีอ่บรม : 26-27 มนีาคม 2568 

4. Sprite สไปร์ท คือภาพ 2D ที่ใช้เป็นตัวละคร, วัตถุ หรือองค์ประกอบต่าง ๆ ในเกม  

 
 

5. Tilemap ไทล์แมพ เป็นระบบที่ใช้จัดวางฉากโดยใช้ Tiles (กระเบื้อง) เล็ก ๆ ใช้สร้างแผนที่, พื้นหลัง, และ
ฉากเกมแบบตาราง 
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เอกสารประกอบการอบรม หลักสูตร “No-Code Game Camp: สร้างเกมสุดมันส์ ไม่ต้องเขียนโค้ด” 
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วันทีอ่บรม : 26-27 มนีาคม 2568 

6. Behaviors บิเฮฟ'วิเออะ คือพฤติกรรมหรือการกระทำที่กำหนดให้กับวัตถุในเกม  

 
 
7. Variables วาริเอเบิล (ตัวแปร) ใช้เก็บข้อมูล เช่น คะแนน, พลังชีวิต, ตำแหน่ง 
8. Spawn สพอน คือการสร้างวัตถุขึ้นมาในเกม เช่น ศัตรู ไอเทม หรือลูกกระสุน ใช้กับระบบสุ่ม หรือกำหนด
ตำแหน่งเกิดของวัตถุ 

 
 

9. Event อีเวนท์ เป็นสิ่งที่ทำให้เกมโต้ตอบกันได้ ใช้สร้างเงื่อนไข เช่น "ถ้าผู้เล่นกดปุ่ม X  ให้กระโดด" 
10. Condition คอนดิชั่น เงื่อนไข  “ถ้าผู้เล่นกดปุ่ม X” 
11. Action แอคชัน การกระทำเมื่อตรงเงื่อนไข “ให้กระโดด” 
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วันทีอ่บรม : 26-27 มนีาคม 2568 

12. Layer เลเยอร์ คือชั้นขององค์ประกอบต่าง ๆ ในเกม ใช้แยก Sprite, UI, ฉากหลัง, เอฟเฟกต์ 

 
13. interface อินเทอร์เฟซ คือส่วนติดต่อผู้ใช้ (UI) ในเกม รวมถึงเมนู ปุ่ม แถบพลังชีวิต และข้อมูลบนหน้าจอ 

 
14. Collision คอลลิชั่น การตรวจจับการชนกัน เป็นกระบวนการในเกมที่ใช้เพ่ือตรวจสอบว่าวัตถุสองชิ้น
สัมผัสหรือชนกันหรือไม่ 

 
 

 

  



9 

เอกสารประกอบการอบรม หลักสูตร “No-Code Game Camp: สร้างเกมสุดมันส์ ไม่ต้องเขียนโค้ด” 
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โปรแกรมที่ใช้ในการพัฒนาเกม 
1. Unity  

 
จุดเด่น: 

1. รองรับ ทั้ง 2D และ 3D 
2. ใช้ C# และรองรับ Visual Scripting (No-Code) 
3. มี Asset Store ขนาดใหญ่ 
4. ข้ามแพลตฟอร์ม (Multiplatform) รองรับ PC, Console, Mobile, VR 

ข้อดี: 
1. ฟรี สำหรับรายได้ต่ำกว่า $100,000/ปี 
2. รองรับ WebGL ทำเกมเล่นบนเบราว์เซอร์ 
3. มีชุมชนขนาดใหญ่ & เรียนรู้ง่าย 

ข้อเสีย: 
1. ต้องติดตั้งลงเครื่อง 
2. ต้องใช้ C# ถ้าทำเกมที่ซับซ้อน 
3. ประสิทธิภาพ 3D อาจสู้ Unreal Engine ไม่ได้ 

เหมาะกับ: ระดับกลาง - มืออาชีพ 
ต้องติดตั้งไหม?:  ต้องติดตั้ง (Windows, Mac, Linux) 
ฟรี/เสียเงิน: ฟรี (มีเวอร์ชัน Pro $399/ปี) 
Export ได้: PC, Mac, Linux, WebGL, Android, iOS, Console (PS/Xbox/Switch), VR/AR 
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2. Unreal Engine 

 
จุดเด่น: 

1. Blueprint (Visual Scripting) สำหรับ No-Code 
2. รองรับ C++ สำหรับการพัฒนาขั้นสูง 
3. กราฟิกคุณภาพ AAA เหมาะกับเกม 3D 
4. เหมาะสำหรับ Console และ PC ระดับสูง 

ข้อดี: 
1. ใช้ฟรี ถ้ารายได้ต่ำกว่า $1 ล้าน/ปี 
2. เครื่องมือ AI, Physics, Animation ระดับสูง 
3. รองรับ VR/AR 

ข้อเสีย: 
1. ใช้ทรัพยากรเครื่องสูง 
2. มี Learning Curve สูงกว่าสำหรับมือใหม่ 

 
เหมาะกับ: ระดับกลาง - มืออาชีพ 
ต้องติดตั้งไหม? : ต้องติดตั้ง (Windows, Mac, Linux) 
ฟรี/เสียเงิน: ฟรี (เสีย 5% ส่วนแบ่งถ้ารายได้เกิน $1 ล้าน) 
Export ได้: PC, Mac, Linux, Android, iOS, Console (PS/Xbox/Switch), VR/AR 
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3. Godot 

 
จุดเด่น 

1. ฟรี 100% ไม่มีค่าลิขสิทธิ์ 
2. ใช้ GDScript (คล้าย Python) หรือ C# 
3. รองรับทั้ง 2D และ 3D (แต่ 2D ดีกว่า) 
4. รองรับ Web (HTML5), PC, Mobile 

ข้อดี 
1. ไม่เสียเงิน ใช้ทำเกมเชิงพาณิชย์ได้เลย 
2. ขนาดเบา ใช้ทรัพยากรเครื่องน้อย 
3. รองรับ Export WebGL 

ข้อเสีย 
1. ชุมชนยังเล็กกว่า Unity & Unreal 
2. 3D Engine ยังไม่เทียบเท่า Unreal 

 
เหมาะกับ มือใหม่ - อินดี้ - ระดับกลาง 
ต้องติดตั้งไหม ต้องติดตั้ง (Windows, Mac, Linux) 
ฟรี/เสียเงิน ฟรี 100% 
Export ได้ PC, Mac, Linux, Android, iOS, WebGL 
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4. GDevelop 5 

 
 

จุดเด่น 
1. No-Code (Event System) ใช้งานง่าย 
2. พัฒนาเกม Web (HTML5) ได้โดยตรง 
3. มี Asset Store ฟรี 

ข้อดี 
1. ทำงานผ่านเว็บได้ หรือดาวน์โหลดมาติดตั้งก็ได้ 
2. เรียนรู้ง่าย เหมาะกับมือใหม่ 
3. ฟรี (มีเวอร์ชันพรีเมียมสำหรับฟีเจอร์เสริม) 

ข้อเสีย 
1. ไม่รองรับ 3D 
2. มีข้อจำกัดด้าน Performance สำหรับเกมท่ีซับซ้อน 

 
เหมาะกับ มือใหม่ - อินดี้ 
ต้องติดตั้งไหม ไม่จำเป็น สามารถใช้งานผ่านเว็บได้ หรือดาวน์โหลดมาติดตั้ง 
ฟรี/เสียเงิน ฟรี (มีเวอร์ชัน Pro ราคา $8+/เดือน) 
Export ได้ PC, Mac, Linux, Android, iOS, WebGL 
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5. Flowlab.io 

 
จุดเด่น 

1. ไม่ต้องติดตั้ง ใช้งานผ่านเว็บ 100% 
2. ใช้ Visual Editor (No-Code) 
3. รองรับ HTML5, Mobile, PC 

ข้อดี 
1. เหมาะกับมือใหม่มากท่ีสุด 
2. พัฒนาและเล่นเกมผ่านเว็บได้เลย 
3. มี Asset ฟรีให้ใช้ 

ข้อเสีย 
1. เวอร์ชันฟรีสร้างเกมได้แค่ 3 เกม 
2. ไม่รองรับ 3D 

 
เหมาะกับ มือใหม่ - ครู/นักเรียน - อินดี้ 
ต้องติดตั้งไหม ไม่ต้องติดตั้ง ใช้ผ่านเว็บ 
ฟรี/เสียเงิน ฟรี (Pro เริ่มต้น $9/เดือน) 
Export ได้ Web (HTML5), Windows, Mac, Android, iOS 
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แผนกวิชาเทคนิคคอมพวิเตอร์ สาขาคอมพวิเตอร์เกมและแอนเิมชนั วทิยาลัยเทคนิคจนัทบุรี 
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การสร้างเกมแนว Platformer ด้วย GDevelop 5 
1. คำอธิบายเกม 
 เกมแนว Endless Runner ที่ผู้เล่นต้องควบคุมตัวละคร วิ่ง, กระโดด, หมอบ และต้องเอาตัวรอดให้
นานที่สุด โดยความเร็วจะเพ่ิมข้ึนทุก 10 วินาที และคะแนนจะคำนวณจากเวลาที่อยู่รอด 
 1.หน้าเริ่มต้น  

 
 2. หน้าเล่นเกม 

 
 3. หน้าเกมโอเวอร์ 
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2. ออกแบบเกมเพลย์ (Gameplay Design) 
 2.1 การควบคุม  

- วิ่งอัตโนมัติ ไปทางขวาตลอด  
- กระโดด กด Space bar 
- หมอบ กด Left Ctrl 

 2.2 ความท้าทาย 
- ความเร็วเพ่ิมข้ึน ทุก 10 วินาที 
- สิ่งกีดขวางแบบต่างๆ เช่นศัตรูบนพื้นให้กระโดดข้าม และบนฟ้าให้หมอบ 

 2.3 เป้าหมายของเกม 
- อยู่รอดให้นานที่สุดเพื่อทำคะแนนสูงสุด 

 2.4 คะแนน 
- นับเวลาที่อยู่รอด (0.5 วินาที = 1 คะแนน) 

 2.5 เงื่อนไขการตาย 
- ชนอุปสรรค 

3. การออกแบบตัวละคร (Character Design) 
 3.1 ตัวละครหลัก 

- ตัวละครต้องมี แอนิเมชันการวิ่ง (Runing), กำลังกระโดด(Jumping), กำลังลงพื้น(Falling), 
หมอบ 
(Ducking), เจ็บ(Hit/Hurt) 

- มี Collider (Hitbox) ที่เหมาะสมเพ่ือไม่ให้การชนสิ่งกีดขวางดูไม่เป็นธรรมชาติ 
 3.2 การควบคุม 

- ใช้ระบบ Platformer Behavior ของ GDevelop 
4. การออกแบบฉากและสิ่งกีดขวาง (Level & Obstacle Design) 
 4.1 ฉากหลัง (Background) ใช้ Parallax Scrolling เพ่ือให้ฉากดูมีมิติ 
 4.2 พ้ืนที่วิ่ง (Ground) ใช้ Tilemap หรือ Object ขนาดยาว เพ่ือให้พ้ืนดินเลื่อนแบบต่อเนื่อง 
 4.3 สิ่งกีดขวาง (Obstacles) 

- มอนส์เตอร์เดินบนพ้ืน เพ่ือให้กระโดดข้าม 
- มอนส์เตอร์บินบนฟ้า เพื่อให้หมอบ 
- Spawn แบบสุ่ม โดยใช้ Random Timer 

 4.4 การเพ่ิมความเร็ว 
- ทุก 10 วินาที ปรับค่า Speed ของ Background 
- สุ่มเวลาเกิดของมอนส์เตอร์ ตั้งแต่ 0.8-2 วินาที 

5. การออกแบบ UI และระบบคะแนน (UI & Score System) 
 5.1 หน้าจอ Game Start 

- มีปุ่ม Start และคำอธิบายวิธีเล่น 
 5.2 HUD แสดงคะแนน 

- แสดงคะแนนที่ทำได้ที่มุมขวาบน 
- แสดงปุ่มให้ปิดเสียงเพลง 
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 5.3 หน้าจอ Game Over 
- ปุ่ม Restart เพ่ือเล่นใหม่ 

6. การออกแบบระบบเสียง (Sound Design) 
 6.1 เสียงพ้ืนหลัง (BGM) เลือกเสียงที่ไม่รบกวนสมาธิ และตั้งค่าให้ loop  
 6.2 เสียงประกอบ (SFX) 

- เสียง กระโดด  
- เสียง หมอบ  
- เสียง Game Over  

 6.3 ควบคุมเสียง 
- เปิด/ปิด BGM ได้ โดยที่เสียง SFX ยังอยู่ 

7. การ Export และเผยแพร่เกม (Export & Publishing) 
 7.1 Web (HTML5) เล่นบนเว็บของ Gdevelop5 ได้เลย 
 7.2 Web (HTML5) ได้ไฟล์ เพ่ืออัปโหลดขึ้น Server ของตัวเอง 
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แนะนำโปรแกรม GDevelop 5 
 GDevelop 5 เป็นโปรแกรมสร้างเกมแบบ โอเพ่นซอร์ส (Open Source) ที่ออกแบบมาเพื่อให้ผู้ใช้
สามารถพัฒนาเกม 2D ได้ง่ายโดยไม่จำเป็นต้องมีพ้ืนฐานการเขียนโค้ด (No-Code Game Engine) และใช้งาน
ได้ฟรีโดยไม่เสียค่าใช้จ่าย https://gdevelop.io/ 

 
 

 
 

 GDevelop 5 สามารถพัฒนาโปรแกรมได้ทั้งบนเว็บไซต์ และ โหลดโปรแกรมมาติดตั้งลงบนเครื่อง 
สามารถพัฒนาเกมได้ทั้งระบบ IOS , Android, Web , และ EXE   

 

https://gdevelop.io/
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เริ่มพัฒนาเกมบน GDevelop 5 

1. ติดตั้งโปรแกรมและ Create Project 

1.1 ดาวน์โหลดโปรแกรม GDevelop 5 เวอร์ชั่น Windows  https://gdevelop.io/download 

 
1.2 เปิดโปรแกรม และติดตั้ง  

 

  
 

   
 

  

https://gdevelop.io/download
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1.3 เปิดโปรแกรม และ Login  

 
 

 
 
1.4 กดท่ี เมนู Create แล้วกดปุ่ม  Create new game  เพ่ือสร้างโปรเจคใหม่  
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1.5 เลือก Empty Project  

 
 

1.6 เลือกขนาดจอของเกม เป็นแบบ Desktop & Mobile Landscape เพราะทำเกมแบบแนวนอน ตั้งชื่อ
โปรเจคตามต้องการ และเลือกท่ีเก็บไฟล์ จากนั้นกด Create new game  

 
 

1.7 โปรแกรมจะสร้างหน้า โปรเจคของเกม โดยจะมี 2 แทบคือ หน้า scene และหน้า Events  โดยหน้า 
Scene คือส่วนของการ Design และ  Events คือส่วนของการโปรแกรมกำหนดเงื่อนไขต่างๆ  
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1.8 กดเปิดเมนู ที่มุมบนซ้าย ของโปรแกรม  จะพบหน้าเมนูที่ใช้จัดการ properties ของ scene และ 
events 

 
 

  คลิกขวาที่ Untitled Sceneแล้วเลือก Rename เพ่ือเปลี่ยนชื่อ Scene เป็น Game  
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2. แนะนำ Interface ของโปรแกรม 

 
  
 1. พ้ืนที่แสดงผลเต็มจอ  
 2. เมนู Properties ปรับแต่งค่าต่างๆ ของ object ที่เลือก  
 3. Scene Object พ้ืนที่สำหรับแสดง Objects ต่างๆ ที่ Add เข้ามาในโปรเจค 
 4. ปุ่มเพ่ิม object ใหม่  
 5. พ้ืนที่แสดง Layers ของโปรเจค  
 6. ปุ่มแสดง Preview เกม 
 7. แสดงตำแหน่ง X,Y ของเมาส์ 
 8. เปลี่ยนแทบ สลับระหว่าง scene และ events 
 9. ปุ่ม save และดูประวัติเวอร์ชั่น  
 10. เมนูสำหรับเปิด/ปิดแถบต่างๆ เช่น layers / properties / objects  
  



23 

เอกสารประกอบการอบรม หลักสูตร “No-Code Game Camp: สร้างเกมสุดมันส์ ไม่ต้องเขียนโค้ด” 
แผนกวิชาเทคนิคคอมพวิเตอร์ สาขาคอมพวิเตอร์เกมและแอนเิมชนั วทิยาลัยเทคนิคจนัทบุรี 
วันทีอ่บรม : 26-27 มนีาคม 2568 

3. สร้างตัวละคร และปรับแต่ง  

3.1 สร้าง Object ตัวละคร กด add new object  

 หากมี Sprite Sheet ของตัวเองหรือโหลดมาแล้ว ให้ เลือก New object from scratch  
 หากไม่มีให้เลือก Asset ฟรี จาก Asset Store เลือก characters  

 
 
 เลือก Asset ของ GrafxKid https://grafxkid.itch.io/ หากหาไม่เจอให้พิมพ์ GrafxKid ที่ช่องค้นหา  
 

 
 

 
 
 ในแพ็คของ GrafxKid มีตัวละครให้เลือหลายตัว หากกดเข้าไปที่ตัวละคร จะพบว่ามีแอนิเมชันของตัว
ละครนั้นติดมาด้วย  

https://grafxkid.itch.io/%20หาก
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 ในเกมที่จะทำ ต้องใช้ตัวละครที่มีแอนิเมชัน idle , Ducking, Jumping , Falling , Running และ 
Hurt ดังนั้น ให้เลือกตัวละครที่มีแอนิเมชันเหล่านี้ให้ครบ หรือให้ใกล้เคียงท่ีสุด บางตัวละครอาจจะตั้งชื่ออ่ืนที่
ไม่ตรงกัน ให้ลองเปิดแอนิเมชันดูแล้วอาจจะเอาท่าทางอ่ืนมาใช้แทนได้  
 เมื่อเลือกได้แล้วกด Add to the scene แล้วปิดหน้าต่าง asset  
 จะได้ตัวละครที่เลือกไว้มาอยู่ในช่อง Objects  

 
 

 
 

 คลิกขวาที่ object ตัวละคร แล้วเปลี่ยนชื่อเป็น Player เพ่ือง่ายต่อการเรียก  
 

 
3.2 ปรับขนาดตัวละคร ให้ลาก  player ออกมาวางไว้ใน scene จะเห็นว่าตัวละครมีขนาดเล็กมาก  
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 สามารถขยายได้ด้วยการเลือกที่ object player จะข้ึนกรอบของ player แล้วใช้เมาส์เลือกปุ่มมุมขวา 
กด shift ค้าง แล้วลากขยายเพ่ือไม่ให้ scale เพ้ียน  

 
 กด Preview เพ่ือทดสอบ 

 

 จะพบว่าตัวละครเล่นแอนิเมชัน idle อยู่ที่ตำแหน่งที่วางไว้ใน scene   
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3.3 ปรับ Collision ของตัวละคร ให้ ดับเบิ้ลคลิกท่ี object player ในจอ จะข้ึนหน้าต่าง Edit Player  
 เลือกเมนู Edit collision mask เพ่ือแก้ไข collision  

 
 
 จะพบว่าตัวละครมี collision เป็นแบบสี่เหลี่ยมเต็มกรอบของตัวละคร หากพื้นที่ในกรอบสีแดง ชน
กับวัตถุ จะนับว่าตัวละครชนกับวัตถุทันที ดังนั้นจึงควรปรับให้ collision mask ใกล้เคียงกับรูปร่างของตัว
ละครมากท่ีสุด  

 
 

 การปรับ collision จะปรับตามเฟรมของแอนิเมชันต่างๆ ทีละเฟรม ดังนั้น ให้เลือกปรับแค่แอนิเมชัน
ที่ใช้งานอยู่ และมีโอกาสชนกับตัวละคร คือ Running Jumping Falling และ Ducking   
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 โดยเริ่มจาก Running ก่อน ให้เลือก แอนิเมชัน Running ที่เฟรม 0  

 
 

 กด Use a custom collision mask 

 
 

 ปิดการ share collision ของ เฟรม และ แอนิเมชัน เพ่ือไม่ให้ไปเปลี่ยน collision mask ของ
แอนิเมชันอ่ืน  
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 จากนั้นปรับขอบ collision ตามต้องการ  
 อาจจะไม่ต้องละเอียดมาก เพราะต้องปรับเองทุกเฟรมของแอนิเมชัน  

 
 
 เมื่อปรับเฟรม 0 เสร็จแล้ว ให้เปลี่ยนเป็นเฟรม 1 และปรับอีกครั้ง  

 
 

 
 

 ปรับจนครบทุกเฟรมของแอนิเมชัน Running เมื่อครบแล้วให้เปลี่ยนแอนิเมชันอ่ืนแล้วปรับ
เช่นเดียวกัน จนครบทุกแอนิเมชันที่กล่าวมา 
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 ทุกครั้งที่เปลี่ยนแอนิเมชัน อย่าลืมปิดการ share collision ของ เฟรม และ แอนิเมชัน  

 
 
3.4 ตั้งค่า Behaviors ของตัวละคร  
 เมื่อปรับ Collision เสร็จทั้งหมด ให้กด Apply เพ่ือกลับมาหน้า Edit Player อีกครั้ง เลือกแถบ 
Behaviors แล้วกด Add a behaviors 

 
 

 เลือก Platformer Character เพ่ือให้สามารถควบคุมการเคลื่อนที่ของตัวละครได้ 
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 ในเกมที่เป็น Endless runner ตัวละครจะวิ่งไปทางขวาอัตโนมัติโดยไม่ต้องควบคุม ดังนั้นให้ลบเคื่อง
หมายถูกที่ Default control ออก เพ่ือไม่ให้ใช้การควบคุมพ้ืนฐาน (กดลูกศรซ้ายขวา) 
 ปรับค่า parameter ต่างๆ ดังนี้  
 Gravity = 1300 แรงโน้มถ่วงของการกระโดด ยิ่งเยอะ ยิ่งกระโดดต่ำ ยิ่งน้อยยิ่งกระโดดสูง  
  Jump speed = 800 ความเร็วของการกระโดด  
 Max falling speed = 1000 ความเร็วของการตกลงพ้ืน  
 Jump sustain time = 1 ระยะเวลาที่กดปุ่มกระโดดนานขึ้นจะยิ่งกระโดดสูงขึ้น 
 

 
 

 เอาเครื่องหมายถูกที่ Automatically grab platform ledges without having to move horizontally
(จับขอบแพลตฟอร์ม) และ can go down jumpthru platform (ลงจากแฟลตฟอร์มทะลุไปข้างล่าง) ออก
ด้วย  จากนั้นกด Apply เป็นอันเสร็จการตั้งค่าตัวละคร  
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 เมื่อกด Preview อีกครั้ง จะเห็นว่าตัวละครหล่นลงจากอากาศ และหายออกจาก scene ไป 
เนื่องจากไม่มีพ้ืนที่ให้ตัวละครยืน  

   
 

  



32 

เอกสารประกอบการอบรม หลักสูตร “No-Code Game Camp: สร้างเกมสุดมันส์ ไม่ต้องเขียนโค้ด” 
แผนกวิชาเทคนิคคอมพวิเตอร์ สาขาคอมพวิเตอร์เกมและแอนเิมชนั วทิยาลัยเทคนิคจนัทบุรี 
วันทีอ่บรม : 26-27 มนีาคม 2568 

4. สร้าง Platform สำหรับให้ตัวละครยืน   

 กด add a new object เพ่ือสร้าง object ใหม่  

 
 

 เลือก New object from scratch แล้วเลือก Tile map  

 
 

หากก่อนหน้านี้ ใครเคยกด filter เพ่ือหา asset free ไว้ จะขึ้นว่า No result ให้กด Clear all Filters  

  
 

 จะมี Asset tile map ให้เลือก หรือหากต้องการใช้ของที่ดาวน์โหลดมา ให้เลือก skip แต่ในบทเรียน
นี้จะใช้ Asset ที่โปรแกรมมีให้ ให้เลือก tile map ใดก็ได้ ตามที่ชอบ ตัวอย่างนี้จะใช้ Asset ที ่7  
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เมื่อเลือกแล้วจะขึ้นมาท่ีช่อง object ให้คลิกขวาที่ tile map แล้วเลือก rename เพ่ือเปลี่ยนชื่อเป็น  
platform 
 

   
 
 ลาก platform มาวางไว้ใน Scene แล้วเลือกที่ object จะขึ้น Properties ของ Platform ให้
จัดการ  
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 ให้เลือกตำแหน่งที่ต้องการใน Tilemap painter แล้วใช้เมาส์คลิก จะข้ึนกรอบสีแดง  

 
   
 จากนั้นให้ไปวาดที่ scene โดย Platform จะยังเล็กอยู่ ให้ลากยาวๆ เพื่อเป็นพ้ืนที่ยืนก่อน  

  
 

 เมื่อวาดเสร็จแล้ว ให้กดยกเลิกปุ่ม paint (หรือ Esc) เพ่ืออกจากโหมดวาด จากนั้นจึงกดปุ่ม Shift 
แล้วขยายให้ขนาดพอดีและปรับตำแหน่งให้เหมาะสม 
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 ถ้าขยายแล้วยังไม่เต็ม Scene ให้กดท่ี paint แล้ววาดต่อจากเดิม 
 

 
  
 เมื่อสร้างเสร็จแล้ว ให้ดับเบิลคลิกที่ Platform ในช่อง Object เพ่ือเปิดหน้าต่าง Edit platform  
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 มาท่ีแถบ Behaviors แล้วกด Add a behavior  

 
 
 เลือก Platform เพ่ือกำหนดให้ Object นี้เป็น Platform 

 
 
 ไม่ต้องปรับค่าใดๆ ให้กด Apply แล้วปิดหน้าต่างได้เลย  

 
 

 กด Preview ดูอีกครั้ง จะพบว่าตัวละครร่วงลงจากตำแหน่งเริ่มต้น ไปยืนอยู่ที่พ้ืนแล้ว  
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5. ตั้งค่า Events เพื่อควบคุมตัวละคร  

 การควบคุมตัวละคร ใช้ 2 ปุ่ม คือ  
  1. กด Space Bar เพ่ือกระโดด (Jumping) 
  2. กด Ctrl ข้างซ้าย เพื่อหมอบ (Ducking) 
 กำหนดเงื่อนไข(Condition) และการกระทำเมื่อตรงเงื่อนไข (Action) 
 1. Condition : กด Space Bar 
     Action : 1. Player กระโดด 
 2. Condition : กด Left Ctrl 
     Action : เปลี่ยนแอนิเมชัน Player เป็น หมอบ(Ducking)  
 เมื่อออกแบบ Event ของการควบคุมตัวละครแล้ว ให้ไปที่หน้า Events  

 
 

 ในหน้า Events สามารถเพ่ิม Group Events ได้ เพ่ือจัด Events หมวดหมู่และง่ายต่อการทำงาน ให้
กดเครื่องหมาย + ที่เมนูด้านบนขวามือ แล้วกด Event group  

 
 

 จะได้แถบสีฟ้า ตั้งชื่อสำหรับ Group event นี้ ว่า Control Player 
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 สามารถเปลี่ยนลำดับของ Events ต่างๆ ได้โดยการใช้เมาส์คลิกค้างที่แถบด้านหน้า event นั้นๆ แล้ว
เลื่อนขึ้นเลื่อนลงไปยังตำแหน่งที่ต้องการ ให้เปลี่ยนตำแหน่งของ Events Group Control player ไว้ด้าน
บนสุด  

 
 จากนั้น ลากแถบ event เปล่า มาไว้ให้อยู่ภายใต้ของ Control player 

   
 
 กดท่ี Add Condition เพ่ือสร้างเงื่อนไข จะเข้าสู่หน้าต่างของ Condition ให้เลือก Object ที่
ต้องการตั้งเงื่อนไข โดยเงื่อนไขแรกจะตั้งว่า “กด Space Bar” ดังนั้น object ที่จะใช้ คือการกด keyboard 
ให้พิมพ์ในช่องค้นหาว่า Key pressed หรือเลือกแถบ Other Conditions แล้วเลื่อนหา Key pressed 

 
 เลือก key ที่ตั้งการตั้งเงื่อนไข หรือพิมพ์ Space เพ่ือเลือกปุ่ม spacebar จากนั้นกด OK 
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 เมื่อเสร็จแล้ว จะขึ้น Condition ที่หน้า Events จากนั้นให้กด Add action  

 
 Action ที่ตั้งไว้เมื่อมีการกด Space bar คือ Player จะกระโดด ดังนั้นให้เลือกท่ี Player  

 
 จะข้ึน Action ที่ Player สามารถทำได้ขึ้นมา 

 
 ให้เลื่อนหา Simulate jump key press ที่อยู่ในหมวดหมู่ของ Platformer Controls เพ่ือให้ 
Player แสดงท่าทางเหมือนมีการกดปุ่มกระโดด (ตาม Default Control ของ Behaviors Platformer 
Character ที่เคยเพิ่มไว้) จากนั้นกด OK  
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 จะได้ event ที่มีเงื่อนไขว่า หาก space ถูกกด ให้ตัวละครกระโดด 

 
 

 กด  แล้วลองกดปุ่ม Space bar จะได้ตัวละครที่กระโดดได้แล้ว แต่ท่าทางของ
ตัวละครยังคงยืนนิ่ง แม้ว่าจะกระโดด  
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6. เปลี่ยน Animation ตัวละคร  

 เมื่อกดกระโดดแล้ว ท่าทางของตัวละคร จะถูกเปลี่ยนเป็นกระโดด และเมื่อกดหมอบ ท่าทางของตัว
ละครก็จะถูกเปลี่ยนเป็นหมอบเช่นกัน  

 ให้กด Add a new Event เพ่ือสร้าง Event ใหม่ จะได้ช่องใส่ Condition เพ่ิมอีก 1 ช่อง 

  

 ลาก event เข้ามาอยู่ภายใต้ Control player เหมือนเดิมแล้วกด Add Condition ของ Event อัน
ใหม่ 

 

 เลือกที่ Player เลือก Action เป็น Is Jumping แล้วกด OK  

 
  

  



42 

เอกสารประกอบการอบรม หลักสูตร “No-Code Game Camp: สร้างเกมสุดมันส์ ไม่ต้องเขียนโค้ด” 
แผนกวิชาเทคนิคคอมพวิเตอร์ สาขาคอมพวิเตอร์เกมและแอนเิมชนั วทิยาลัยเทคนิคจนัทบุรี 
วันทีอ่บรม : 26-27 มนีาคม 2568 

 กด Add action ของ Player is jumping เพ่ือเพ่ิม action  

 

 เลือก Player > Animation(by name) > Choose an animation เป็น Jumping แล้วกด 
OK 

 
 

 
 

 ให้กด Preview ดู จะพบว่า แอนิเมชันเปลี่ยนแล้ว แต่เปลี่ยนค้างไว้ตลอด เป็นเพราะยังใส่เงื่อนไขของ
การเปลี่ยนแอนิเมชันไม่ครบ 
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 ตั้งเงื่อนไขของแอนิเมชันดังนี้  
 1. Player อยู่บนพื้น ให้เปลี่ยนแอนิเมชันเป็น วิ่ง (เพราะเมื่อเริ่มเกมจะวิ่งอัตโนมัติ ดังนั้นต้องตัง้ให้ว่ิงไว้ก่อน)  
  Condition : Player is on Floor  Action : Change Animation Player to Running 
 2. Player กระโดด ให้เปลี่ยนแอนิเมชันเป็น กระโดด (ทำไปแล้ว) 
  Condition : Player is Jumping  Action : Change Animation Player to Jumping 
 3. Player กำลังร่วง ให้เปลี่ยนแอนิเมชันเป็น กำลังร่วง  
  Condition : Player is Falling  Action : Change Animation Player to Falling  
 4. เมื่อกด Left Control ให้เปลี่ยนแอนิเมชันเป็น หมอบ 
  Condition : LControl is pressed  Action : Change Animation Player to Ducking 
 
 เมื่อตั้งเงื่อนไขได้แล้ว ให้เริ่มทำการสร้าง Event ใหม่ทุกครั้งที่มีเง่ือนไขใหม่ และนำ Event เข้ามาอยู่
ใน Group ของ Control Player ด้วย 

 
 เมื่อกด Preview จะพบว่าสามารถควบคุมการกระโดด และหมอบ ได้แล้ว แต่ยังมีการกระโดดและ
หมอบพร้อมกันได้อยู่ จึงต้องเพ่ิมเงื่อนไขเพ่ิมเติมลงใน Event ของการกด L Control เพ่ือหมอบ โดยเงื่อนไข
คือ Player ต้องไม่ได้กระโดดอยู่ 

    
 

ให้กด Add condition ที่อยู่ Event เดียวกับ LControl key is pressed  
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 เลือก Player > Is jumping > เลือก Invert Conditon เพ่ือให้เป็นเงื่อนไขที่ตรงข้ามกันกับกระโดด 
แล้วกด OK 

 
 

 
 

 กด Preview ดูอีกครั้ง จะหมอบตอนอยู่บนฟ้าไม่ได้แล้ว  
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7. สร้างการ Double Jump  

 ให้กลับมาที่หน้า Scene แล้วย่อขนาด Player กับ Platform ให้เล็กลง เพราะหากทำการกระโดด 2 
ชั้น แล้วตัวละครใหญ่ไป จะหลุดออกนอกจอ 

 
 

 สร้าง event group ใหม่ แล้วให้อยู่ภายใต้ Control player ตั้งชื่อว่า double jump พร้อมสร้าง 
Event ใหม่ ใน group นั้นด้วย  
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 ในการกำหนดเงื่อนไขของการ Double Jump จะตรวจสอบจำนวนการกระโดดก่อน ว่ากระโดดครบ 
2 ครั้งหรือยัง ดังนั้นจะมีการสร้างตัวแปรของ Player  
  
 ให้ไปทีห่น้า Scene คลิกขวาที่ Player ในรายการ Object เลือก Edit Object variable 

 
 
 จะได้หน้า Edit Player ที่แถบของ Variables ให้กด Add a variable 

 
  
 ให้เปลี่ยนชื่อตัวแปรเป็น JumpCount เลือกชนิดเป็น Number และค่าเริ่มต้นเป็น 0  
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 กำหนดเงื่อนไขของ Double Jump ดังนี้  
 1.ในขณะที่ Player กระโดด(Jumping) หรือ กำลังร่วง(Falling)  
   หากกด Space Bar และ ตัวแปร JumpCount มีค่าน้อยกว่า 2  
   จะอนุญาตให้ Player กระโดดอีกครั้ง และจะนับ JumpCount + 1 (เนื่องจากมีการกระโดดไปแล้ว 1 
ครั้ง) 
   โดยเงื่อนไขนี้จะทำงานแค่ 1 ครั้ง 
  Condition :  
   1. Player is jumping OR Player is falling  
   2. Key Space is pressed  
   3. JumpCount < 2 
   4. Trigger Once  
  Action :  
   1. Allow Player Jump again 
   2. JumpCount add 1   
 
 2.  ถ้า Player อยู่บนพ้ืน จะรีเซ็ทค่า JumpCount เป็น 0 
  Condition :  
   Player is on floor 
  Action :  
   JumpCount set to 0 
 3. ในตอนเริ่มเกม จะกำหนดใหค้่า JumpCount เปน็ 0 
  Condition :  
   At the beginning of the scene 
  Action :  
   JumpCount set to 0 
 
 ในการเพ่ิมเงื่อนไข OR ให้ กดที ่Add condition พิมพ์ “or” ในช่องค้นหา  
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 จากนั้นกด Add a sub-condition แล้วเพ่ิมเงื่อนไข Player is jumping และ Player is falling เข้าไป 

 
 

 
 

 จากนั้นกด Add condition เพ่ือเพ่ิมเงื่อนไข Key space is pressed  

  

 
  
 ในการเพ่ิมเงื่อนไขของการตรวจสอบค่าตัวแปร The variable JumpCount of Player < 2 ให้กด Add 
condition อีกครั้งใต้ Space key is pressed เลือก Player ใน Condition แลว้ค้นหา Variable value ดังนี้  
 1. เลือก Player 
 2. ค้นหาและเลือก variable value 
 3. เลือกตัวแปร JumpCount 
 4. เลือกสัญลักษณ์ < น้อยกว่า  
 5. ใส่ค่า 2 
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 สร้างเงื่อนไข Trigger Once กด Add condition ใน Event เดียวกัน จากนั้นพิมพ์ค้นหา Trigger 
แล้วเลือก Trigger once while true แล้วกด OK  

 
  
 จะได้เงื่อนไขท้ังหมด อยู่ใน Event เดียวกัน เนื่องจาก Event นี้ต้องเช็คทุกเงื่อนไขให้ตรงกัน จึงจะ
ทำงาน Action ที่กำหนดไว้  

 
 

 ใส่ Action ให้ Event ที่ 1 คือ 1. Allow Player Jump again 2. JumpCount add 1 กดที ่Add 
action  

 

   



50 

เอกสารประกอบการอบรม หลักสูตร “No-Code Game Camp: สร้างเกมสุดมันส์ ไม่ต้องเขียนโค้ด” 
แผนกวิชาเทคนิคคอมพวิเตอร์ สาขาคอมพวิเตอร์เกมและแอนเิมชนั วทิยาลัยเทคนิคจนัทบุรี 
วันทีอ่บรม : 26-27 มนีาคม 2568 

 1. Allow Player Jump again 

 
 2. JumpCount add 1 

 
 

 
 

 จะได้ event ที่ 1 ของการสร้างเงื่อนไขให้สามารถ double jump ได้  

 
 

 สร้าง Event ที่ 2 ของการ double jump ให้กด Add a new event แล้วลาก event ใหม่ให้เข้า
มาอยู่ภายใต้ Group ของ Double Jump  
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 ลาก event ใหม่ให้เข้ามาอยู่ภายใต้ Group ของ Double Jump  

 
  

 กด Add condition ที่ Event ที่ 2 เพื่อสร้างเงื่อนไข   
 2.  ถ้า Player อยู่บนพื้น จะรเีซ็ทค่า JumpCount เป็น 0 
  Condition :  
   Player is on floor 
  Action :  
   JumpCount set to 0 
 เลือก Player > Is on floor กด OK แลว้กด Add action  เพ่ือเพ่ิมการกระทำ  
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 เพ่ิม Event ใหม่ เพ่ือสร้างเงื่อนไขที่ 3 แล้วลาก event เข้ามาอยู่ภายใต ้group ของ double jump 

 
 กด add Condition เพ่ือสร้างเงื่อนไข At the beginning of the scene 
 3. ในตอนเริ่มเกม จะกำหนดให้ค่า JumpCount เป็น 0 
  Condition :  
   At the beginning of the scene 
  Action :  
   JumpCount set to 0 
 เลือก Other conditions แลว้เลือก Scene > At the beginning of the scene แลว้กด OK  

หรือค้นหาโดยการพิมพ์ begining

 
 เพ่ิม Action หากเป็น Action เดียวกัน สามาร Copy ได้ดว้ยการกด Control ค้างไว้แลว้ลาก Action ที่
ต้องการลงมาได้เลย  
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 เมื่อสร้างเงื่อนไขครบแล้ว ตัวละครจะสามารถ double Jump ได้ ให้ทดสอบด้วยการกด Preview 
แล้วกดกระโดด ในขณะที่ Player กำลังลงพื้น จะกดกระโดดอีกครั้งได้ 
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Events Sheet ปัจจุบัน 
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8. การทำ Scene Scrolling 

 สร้าง Layer ชื่อว่า Background สำหรับใส่ภาพพ้ืนหลัง มาที่หน้า Game Scene กด Add a layer 

 

   

 คลิกท่ี  แล้วลากลงมาให้อยู่ข้างล่าง Base layer  

 
 เลือกที่ layer Background แล้วกด Add a new object  
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 เลือก Tiled Sprite เพ่ือเพ่ิมภาพพ้ืนหลัง  

 
 
 ตั้งชื่อว่า background_1 แล้วกด Choose a file เพ่ือเลือกภาพพ้ืนหลังที่เตรียมไว้ 
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เลือกภาพที่ชื่อว่า Background_1 เพ่ือใช้เป็น mid background หรือพ้ืนหลังที่อยู่ใกล้กว่า  

 
 เมื่อเลือกไฟล์แล้ว โปรแกรมจะตรวจจับได้ว่าไฟล์ที่เลือกนั้นอยู่นอกโฟลเดอร์ของโปรเจค แนะนำให้ทำ
การ Copy ไฟล์นั้นมาไว้ในโฟลเดอร์เดียวกับโปรเจคก่อน ก่อนที่จะ Import ให้กด OK โปรแกรมจะ Copy ให้
อัตโนมัติ 

 
 

 จะได้ดังนี้ 
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 ให้เพิ่ม Object แบบเดียวกัน โดยเลือกภาพ Background_2  

 
 

 เสร็จแล้วจะได้ Object สำหรับ Background มา 2 ภาพ ให้ลาก Background_2 มาวางไว้ที่มุมซ้าย
บนของ Scene ก่อน แล้วขยายให้เต็มจอ 
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 Object ประเภท Tile Sprite จะทำการ Repeat ภาพเองหากขยายเกินขนาดของภาพ ดังนั้นเวลาเต
รีบมภาพสำหรับใช้เป็น Tile Sprite ให้เตรียมภาพที่พอดีกับขนาดของจอ เพ่ือที่จะให้ภาพเคลื่อนไหวไปด้าน
ข้าวโดยอัตโนมัตได้ 

 

 ปรับขนาดของภาพให้พอดีแล้วขยับให้อยู่กลาง Scene  
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ทำแบบเดียวกันกับ Background_1 เมื่อขยายเต็ม Scene แล้ว จะพบว่าก้อนเมฆซ้อนกันอย่างมีมิติ 

 

 จากนั้นจะทำการให้ก้อนเมฆเคลื่อนที่ไปทางซ้าย เพราะ Player วิ่งไปทางขวา ให้ภาพ 
background_1 เคลื่อนที่ช้ากว่า เพราะอยู่ไกล และ Background_2 เคลื่อนที่เร็วกว่า เพราะอยู่ใกล้ 
 ให้ไปที่หน้า Event Sheet เพ่ิม Group Event ด้วยการคลิกขวา ที่ คำว่า Add a new Event ด้าน
ล่างสุด แล้วเลือก Event Group ตั้งชื่อว่า Scene scrolling 
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 กด Add a new event แล้วลากให้อยู่ภายใต้ Scene scrolling 

 
  
 การทำให้ภาพพ้ืนหลังเคลื่อนไหม ไม่จำเป็นต้องกำหนดเงื่อนไข จึงสามารถสร้าง Action ได้เลย โดยที่
ไม่มีเงื่อนไขใดๆ ให้กดที่ Add action เลือก background_1 > Image X Offset > +3  
 เพ่ือให้ภาพเลื่อนไป 3 pixel ตลอดเวลา  

 
  

 

 ทำเช่นเดียวกันกับ Background_2 อยู่ใน Event เดียวกัน แต่ให้ add แค่ 1 เพราะเป็นท้องฟ้าที่อยู่
ไกลกว่า จึงควรเลื่อนช้ากว่า 
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 กด Preview จะพบว่าท้องฟ้าเคลื่อนไหวแล้ว ซึ่งจะเคลื่อนไหวไม่พร้อมกัน ทำให้ท้องฟ้าดูมีมิติมากขึ้น 
สามารถปรับเพิ่มลดความเร็วของท้องฟ้าได้ตามต้องการ ซึ่งในอนาคต จะเปลี่ยนจากเลข 3 และ เลข 1 ที่
กำหนดไว้เป็นค่าคงที่ ให้เป็นตัวแปร เพ่ือให้ท้องฟ้าเคลื่อนที่เร็วขึ้นเมื่อเวลาผ่านไป ทำให้ดูเหมือนว่าตัวละครวิ่ง
เร็วขึ้น  
 

 
 
 เมื่อพื้นหลังเคลื่อนทีแ่ล้ว แต่ platform ยังไม่เคลื่อนที่ เนื่องจาก platform เป็น Object ประเภท 
Tilemap ไม่ใช่ Tile Sprite จึงไม่สามารถใช้วิธีเดียวกันกับ background ได้  

 ในการทำให้ Platform เคลื่อนที่นั้น จะใช้การ Repeat object โดยเริ่มจากการ Copy platform 
ขึ้นมาก่อน แล้วเอามาวางต่อกัน  
 ให้เลือก platform ที่อยู่ใน Scene กด Copy แล้ว past  
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 ให้สังเกตว่า platform ที่เพ่ิมขึ้นมานั้นยังเป็น Object ตัวเดียวกันกับ platform ตัวแรกอยู่ จากที่
รายการ Object ยังมีรายการของ Platform แค่รายการเดียว 

 
 

 ให้จับ Platform วางต่อกัน ในระนาบเดียวกัน โดยสามารถกำหนดตำแหน่งของ Platform ทั้งสองได้
จากเมนู Propertise ด้านซ้ายมือ เมื่อกดที่ Platform นั้นๆ  
 Platform อันแรก ตำแหน่ง X อยู่ที่ 0 เพราะขอบด้านซ้ายสุดอยู่ติดกับขอบ Scene พอดี โดยมีความ
กว้าง(W) อยู่ที่ 1380 แสดงว่าตำแหน่ง X ของPlatform ที่2 ควรจะอยู่คือ 1380 ซึ่งจะต่อจาก Platform แรก
พอดี 
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 ให้ปรับ X ของ Platform ที่ 2 เป็น 1380 และปรับค่า Y เป็น 591 จะต่อท้ายกับ Platform ที่ 1 
พอดี

 
  
 จากนั้นสามารถปรับแต่ง Platform ได้ตามชอบโดยเลือก Tilemap จากเมนูมาวาดบน platform 
นั้นๆ ได้เลย  

 
 
เมื่อปรับแต่งเสร็จแล้ว ให้ดับเบิ้ลคลิกที่ Platform ในเมนู Object เพ่ือเปลี่ยนพื้นที่สำหรับ Hit Box ก่อน  
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 ในหน้า Edit Platform ส่วนที่เป็นกรอบสีแดงในพ้ืนที่ Tilemap คือส่วนที่ Player สามารถเหยียบได้ 
และเดินผ่านทะลุไม่ได้ จะเรียกส่วนนี้ว่า tile’s hit boxes  
 เนื่องจากเกมแนว Endless runner มักจะใช้แค่พื้นเป็นที่เหยียบ ไม่มี Platform ที่ลอยฟ้า เหมือน
เกมประเภทเก็บเหรียญ ที่ต้องควบคุมตัวละครเอง ดังนั้น  tile’s hit boxes ควรจะมีแค่ส่วนที่เป็นพื้นเท่านั้น 
เพราะเราจะใช้ส่วนอื่นเป็นการตกแต่งฉากหลังไป หากเอาส่วนที่เป็น hit box ไปใส่ในฉากหลัง จะทำให้ตัว
ละครเดินผ่านไม่ได้ เช่นในกรณีนี้ หากเลือกไส้กรอกที่มี Hit box ไปแต่งฉากหลัง จะทำให้ตัวละครวิ่งผ่านไส้
กรอกไม่ได้ ต้องกระโดดข้ามเท่านั้น ซึ่งไม่ควรเกิดขึ้นในเกมที่เป็น Endless Runner หากเกิดการชนแล้วควร
ให้เกมจบทันที  

 
 
 ให้ใช้เมาส์คลิกส่วนที่เป็นกรอบสีแดง ในส่วนที่ไม่ต้อการออกให้หมด เพ่ือนำไปตกแต่งฉากหลังได้ โดย
ไม่มีปัญหา เสร็จแล้วกด Apply เพ่ือปิดหน้าต่างได้เลย  

 
 

 ตั้งค่า Event เพื่อให้ platform เคลื่อนที่ โดยจะใช้การ Repeat เมื่อ ตำแหน่งของ platform ถูก
เลื่อนไปจนน้อยกว่าค่าติดลบของความกว้างของ platform  
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 Platform มีขนาด 1380 และเริ่มต้นที่ตำแหน่ง X = 0  
 ตำแหน่ง X ของ platform จะลดลงเรื่อยๆ เพื่อเคลื่อนที่ไปด้านซ้ายมือ เช่น ตั้งค่าให้ ลดลงทีละ 3 
หมายถึง platform จะถูกเลื่อนไปด้านซ้ายมือทีละ 3 พิกเซล  
  

 
 
 จนเมื่อ platform แรกใกล้หมด ตำแหน่ง X ของ platform แรกจะเป็นค่าติดลบ หาก platform พ้น
ขอบ scene จะเป็นค่าติดลบเท่ากับความกว้างของ platform พอดี  
 

 
  
 เมื่อตำแหน่ง X น้อยกว่า -1380 แล้ว (แสดงว่า platform1 พ้น Scene หมดแล้ว platform2 เลื่อน
มาแทนที่) จะทำการเปลี่ยนตำแหน่ง X ของ platform1 เพื่อให้ platform1 ได้กลับไปเริ่มใหม่ โดยจะให้ไป
เริ่มใหม่ที่ตำแหน่ง X = 1380 หรือตามความยาวของ platform (platform.Width()) ซึ่งไม่ได้เริ่มที่ 0 เพราะ
ปัจจุบัน platform 2 กำลังอยู่ที่ตำแหน่ง 0 อยู่แล้ว การให้ไปเริ่มที่ 1380 คือการไปต่อท้าย platform 2 
นั่นเอง 
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 สร้าง Event เพ่ือ repeat platform ในเมนูมุมขวาบน ให้กดเครื่องหมาย + แล้วเลือก For each 
Object  

 
 

 จะได้ Event ที่เป็น Repeat for each instance of : ให้เลือก Select an object แล้วเลือกเป็น 
platform 

 
 

 
 กด Add condition เพ่ือเพ่ิมเงื่อนไข ตำแหน่ง X ของ platform มีค่าน้อยกว่า -
platform.width() (-1380) 
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 เลือก platform > X position > เลือกเครื่องหมายน้อยกว่า > ใส่ค่า -platform.Width() 

 
 
 ได้ดังนี ้ให้กด Add action แล้วเปลี่ยนค่า X ของ platform ให้เป็นค่าความยาวของ platform โดย
ใช้  
Change X position of platform set to platform.width() 

 
 

เลือก platform > X position > เลือกเครื่องหมายเท่ากับ platform.Width()

 
 

กด Add a new event เพ่ือเพ่ิม event ใหม่ แล้วลากให้อยู่ภายใต้ของ Scene scrolling  

 
 

 
 ใส่ Action ของการเลื่อนตำแหน่ง x ของ platform ทีละ 3 โดยไม่ต้องใส่ Condition เพราะให้ทำ
ตลอดเวลาอยู่แล้ว 
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 เลือก Platform > X position > เครื่องหมายลบ ( - ) และใส่ค่า 3  

 

 ได้ดังนี้  

 
  

 ให้ทดสอบโดยการกด Preview จะพบว่าตัวละครไหลหายไปพร้อมกับฉาก และก้อนเมฆด้านหน้ากับ
ฉากไหลไปพร้อมกัน เพราะตั้งค่าไว้ -3 เท่ากัน 

 
 ให้ตั้งค่าให้ตัวละครอยู่ตำแหน่งเดิมตลอด โดยตามภาพตัวละครจะอยู่ที่ X = 77 สามารถคลิกท่ี 
object player เพ่ือดูตำแหน่งที่แสดงขึ้นมา หรือดูได้ที่เมนู Properties ของ player  
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 เมื่อได้ตำแหน่งตัวละครแล้ว ให้สร้าง Event ใหม่ ภายใต้ Scene Scrolling เลือก Add condition 

 
 

 เลือก Player > X position > เลือกเครื่องหมายไม่เท่ากับ และใส่ตำแหน่ง X ของ Player คือ 77  

 
 

จากนั้นกด Add action เพ่ิมการ set X position ของ player = 77 และเพ่ิม subtract จาก 3 เป็น 4 

 

 

 กด Preview จะเห็นว่าฉากเคลื่อนไหวไม่ตรงกับเมฆแล้ว และตัวละครอยู่ที่เดิม ไม่หลุดออกนอก 
Scene แต่ในช่วงรอยต่อของฉากยังมีความห่างกัน ให้ปรับตำแหน่งการ repeat ของ platform 1 ให้ลดลงอีก
ประมาน 50 เพ่ือให้ platform อยู่ล้ำเข้าไปใน platform 2 เพ่ือปิดช่องว่าง 
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 ใช้วิธีดับเบิลคลิกท่ีค่า parameter ได้เลย จะขึ้นช่องให้เปลี่ยนค่า ให้ใส่ -50 เข้าไปต่อท้ายดังภาพ 

 

 กด Preview อีกครั้งพบว่าฉากไม่ขาดและสามารถเล่นได้ปกติแล้ว เพียงแต่ platform ยังคงไหลใน
ความเร็วเท่าเดิม ถึงแม้ว่าจะเล่นไปเป็นเวลานานแล้ว ซึ่งโดยปกติแล้วควรจะให้ platform ไหลเร็วขึ้นเมื่อเวลา
ผ่านไป เพื่อให้ดูเหมือนวิ่งเร็วขึ้น  

 ดังนั้น ก่อนจะจบการทำ Scene scrolling จะมีการปรับแต่งเพื่อให้ Platform ไหลเร็วขึ้นเมื่อเวลา
ผ่านไป โดยกำหนดเงื่อนไขว่า ทุกๆ 10 วินาที จะให้ฉากไหลเร็วเพ่ิมทีละ 1 px ดังนั้นจะไม่สามารถใช้เลข 4 ได้
แล้ว จึงต้องมีการสร้างตัวแปรของ Scene ขึ้นมาอีกตั้งแปรหนึ่ง ชื่อว่า PlatSpeed 

 ให้มาที่หน้า Scene Game แล้วกดท่ี open setting มุมขวาบนของเมนู  

 
 

 กด Edit scene variables เพ่ือเข้าไปหน้าสร้างตัวแปรของ Scene 
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 จะข้ึนหน้า Game variables ให้กด Add a variable 

 
  
 ตั้งชื่อตัวแปรว่า PlatSpeed กำหนดค่าเริ่มต้นเป็น 4 ตามค่าการไหลของ platform ที่ตั้งไว้ตั้งแต่แรก 
แล้วกด Apply 

 
 จากนั้นให้กดที่เมนูด้านซ้ายบน กดเครื่องหมาย + ที่ Extension  
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 จะได้หน้า Seach for New Extension พิมพ์ในช่องค้นหาว่า repeat เพ่ือค้นหา Repeat every X 
seconds 

 

 กด Install in project เมื่อ install เสร็จแล้ว ให้กด close เพ่ือปิดหน้าต่าง extension ได้เลย 

 
 

 ในเมนู Extensions จะข้ึนรายการ RepeatEveryXSeconds ไปเมื่อครู่นี้ 

 
 

 เมื่อติดตั้ง Extension เรียบรอ้ยแล้ว ให้กลับมาที่หน้า Event อีกครั้ง ในส่วนของ Scene Scrolling 
ให้กด Add a new event แล้วลากให้มาอยู่ภายใต้ Scene scrolling กด Add Condition  
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 ให้มาที่ Other conditions > Repeat every X seconds > Repeat with a scene timer  
 จากนั้นตั้งชื่อว่า “every 10 sec” และใส่เลข 10 ลงในช่อง duration  

 
 

 กด Add action แล้วตั้งค่าให้ตัวแปร PlatSpeed เพิ่มขึ้น 1px ทุกๆ 10 วินาที 

 
 จะได้ Event ดังนี้ 

 
  
 สุดท้ายให้เปลี่ยนค่าท่ีเดิมเป็นเลข 4 ใน event ของ  
 Change the X position of platform :subtract 4 เปลี่ยนจากเลข 4 เป็น PlatSpeed 
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 Event Sheet ของ Scene Scrolling เมื่อเสร็จแล้วจะได้ดังนี้  

 
 

 ทดสอบโดยการเปิด Preview แล้วปล่อยให้ตัวละครวิ่งไปเรื่อยๆ จะเห็นว่าทุกๆ 10 วินาที platform 
จะไหลเร็วขึ้นเรื่อยๆ ตามค่าท่ีตั้งไว้  
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9. สร้างระบบ State Game  

 ในการทำงานของเกม โดยปกติแล้วจะมีการกำหนดเป็น State หรือสถานะของเกม เพื่อระบุว่า 
ปัจจุบัน เกมกำลังอยู่ในสถานะใด โดยมี 3 สถานะ  
 1. Start Game คือ เกมที่เปิดมาตอนเริ่มต้น ยังไม่ได้เริ่มเกม จึงจะแสดงหน้า Start Game และมี
ปุ่มเริ่มเกมให้ผู้เล่นกด ในสถานะนี้ ฉากจะไม่ไหล และตัวละครจะยังไม่วิ่ง ต้องให้กด Start ก่อน ตัวละครจึงจะ
วิ่ง  
 2. Running  คือ สถานะที่เกมกำลังเล่นอยู่ จะเป็นสถานะที่เปลี่ยนหลังจากท่ีผู้เล่นกด Start เกมแล้ว 
ดังนั้นในสถานะนี้ ฉากจะไหล และตัวละครจะวิ่ง และจะมีมอนเตอร์เกิดขึ้นด้วย  
 3. Game Over คือสถานะที่ตัวละครชนกับมอนเตอร์แล้วตาย ในสถานะนี้ ตัวละคร ฉาก และมอน
เตอร์จะหยุดนิ่ง โดยที่ตัวละครจะเปลี่ยนแอนิเมชันเป็น Hurt แล้วจะข้ึนหน้า Game Over ขึ้นมา พร้อมกับปุ่ม 
Restart เกม เมื่อมีการกดปุ่ม Restart เกมจะถูกรีเซ็ทค่าทั้งหมดแล้วกับไปเริ่มต้นใหม่ที่สถานะ Start Game  
  
 ดังนั้น ในการพัฒนาเกม ควรจะสร้างตัวแปรขึ้นมาเพ่ือใช้เป็นตัวแปรที่ระบุสถานะปัจจุบันของเกมด้วย  
 ก่อนที่จะเริ่มทำ interface เกม จะจัดการกับ Event ที่เคยเขียนไป ให้อยู่เป็นหมวดหมู่ก่อน โดยจะมี
ขั้นตอนดังนี้ 
 1. สร้างตัวแปร GameState กำหนดค่าเริ่มต้นเป็น “start” (จะมี 3 ค่าคือ 
“start”,“run”,“over”) 
 2. สร้าง Group Event มา 3 Group โดยให้ชื่อว่า  
  1. Game Start 
  2. Game Running 
  3. Game Over 
 3. ย้าย Group Event เดิมที่เคยสร้างไว้ ให้เข้าไปอยู่ใน Group Event ของ Game Running  
  1. Control Player  
  2. Scene Scrolling  
1. สร้างตัวแปร GameState 
 ไปที่หน้า Scene เลือกเมนู open setting มุมขวาบน เพ่ือสร้างตัวแปร 
 

 

 
กด Add variables ตั้งชื่อว่า GameState เลือกชนิดของตัวแปรเป็น Text และใส่ค่าเริ่มต้นเป็น “start” 
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2. สร้าง Group Event 
 คลิกขวาที่ Add a new event ด้านล่างสุด แล้วเลือก Event group 

   

 ตั้งชื่อว่า Game start  

 
 

 สร้าง Event Group ขึ้นมาอีก 2 Group ตั้งชื่อว่า Game Running กับ Game Over 
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 สร้างเงื่อนไขภายใต Group Event แต่ละ Group ดังนี้  
 คลิกขวาที่ Group Event ของ Game Start > Add > Sub Event  

 
  
 กด Add Condition 

 
 

 ค้นหา Variable value เลือกตัวแปรเป็น GameState = “start”  

 
 
 จะได้ดังนี้ ยังไม่ต้องเพ่ิม Action ใดๆ แต่จะทำการเพ่ิม Sub-Event ภายใต้เงื่อนไขนี้อีกชั้น เมื่อ
ต้องการสร้างเงื่อนไขที่จะให้กระทำตอน Game start  
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 ให้เพ่ิม Sub-event ของ Group Game Running และ Game Over ด้วย โดยจะเพ่ิมในส่วนของ 
Game Over ก่อน ค่อยย้อนกลับมาทำ Game Running  

 
  
 เพ่ิม Condition GameState = “over” 

 
 

 เมื่อทำ Game Start และ Game Over เสร็จแล้ว ต่อไปจะทำในส่วนของ Game Running ซึ่งใน
ส่วนนี้ นอกจากสร้างเงื่อนไขแล้ว ต้องย้าย Event Group ที่เคยทำไว้แล้ว ก็คือ Control Player และ Scene 
Scrolling เข้ามาอยู่ภายใต้ Game Runing ด้วย เนื่องจาก การควบคุมตัวละคร และการทำให้ฉากหลัง
เคลื่อนที่ ควรจะเกิดขึ้นหลังจากท่ีเกมเริ่มแล้วเท่านั้น  
 สร้าง Condition GameState = “run” ใน Sub-event ใต้ Game Running (ทำเหมือน game 
start และ game over) 
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3. ย้าย Group Event เดิมที่เคยสร้างไว้(Control Player, Scene Scrolling) ให้เข้าไปอยู่ใน Group Event 
ของ Game Running ภายใต้เงื่อนไขท่ีสร้างไว้  
 ให้เลือกที่ Control Player แล้วคลิกลากให้เข้ามาอยู่ใน Game Running 
 เลือกพ้ืนที่ในกรอบสีแดง จะเป็นการเลือกท้ังหมดที่อยู่ใน Group ของ Control Player  

 
 

 ลากลงมาแล้วเลื่อนให้อยู่ภายใต้ Game Running สังเกตเส้นสีขาวจะต้องอยู่ใต้เงื่อนไขของตัวแปร 
GameState 
 

 
 

 จะได้หน้าตา Event Sheet ดังนี้ 

 
 จากนั้นให้ลาก Event Group ของ Scene Scrolling เข้ามาเช่นเดียวกัน จะได้ดังนี้  
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 Scene Scrolling จะต้องอยู่ระดับเดียวกันกับ Control Player 
 

 

 

 เมื่อทำการเพ่ิมเงื่อนไข GameState แล้ว หากกด Preview จะพบว่าไม่สามารถทำอะไรได้เลย 
เนื่องจาก GameState ถูกเซ็ทให้ค่าเริ่มต้นเป็น start แต่ event ของการเคลื่อนที่ของตัวละครอยู่ใน run จึง
จะไม่สามารถเล่นเกมได้ในตอนนี้   
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Event Sheet ปัจจุบัน 
  

 
ขยาย Double jump และ Scene Scrolling 
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10. ทำ Interface ของเกม (หน้า Start Game) 

 การทำหน้า Interface เกม ในเกมนี้ จะทำ 3 หน้า คือ  
 1. Game Start สำหรับหน้าแรกของเกม มีชื่อเกมและมีปุ่ม Start ให้กดเพ่ือเริ่มเกม เมื่อกดเริ่มเกม
แล้ว หน้านี้จะต้องถูกซ่อนไว้ ดังนั้นหน้านี้ควรจะอยู่ใน Event ของ Game Start 
 2. Game Run สำหรับแสดงคะแนนวิ่ง และ ปุ่มปิดเสียงดนตรี  โดยคะแนนจะเริ่มนับตั้งแต่กด Start 
ดังนั้น หน้า Game Run ควรจะอยู่ใน Event ของ  Game Running 
 3. Game Over สำหรับแสดงคำว่า Game Over และปุ่ม Restart เพ่ือเริ่มเกมใหม่ ดังนั้นเมื่อเริ่มเกม 
หน้านี้จะต้องถูกซ่อนไว้ และแสดงออกมาอีกครั้งเมื่อตัวละครตาย จึงควรจะอยู่ใน Event ของ Game Over  
  
 ให้ทำหน้า Game Start ขึ้นมาก่อน  
 มาท่ีหน้า Scene แล้วสร้าง Layer ขึ้นมาใหม่ ตั้งชื่อว่า ui_start 

 
 

 เลือกที่ Layer ui_start เพ่ือทำงานใน Layer นี้ 

 
  
 สร้าง Object Sprite ขึ้นมาใหม่  

 
 จะสร้างเป็นพ้ืนหลังสีขาวที่โปร่งแสง เพ่ือคั่นระหว่างเมนูและตัวเกม ดังนั้นให้เลือก Create with 
Piskel 
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จะมีหน้าต่างสำหรับวาดภาพขึ้นมา ให้เลือกสีเป็นสีขาว เลือกถังสี แล้วเทสีขาวลงไปในภาพได้เลย 

  
  
 จากนั้นกด save  

 
 

 จะได้ Sprite ทีม่ี Animation เดียว ให้เปลี่ยนชื่อ Sprite เป็น bg_white แล้วกด Apply 
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 ลาก bg_white มาไว้ใน Scene แล้วขยายให้เต็มหน้า จากนั้นไปที่เมนู properties ข้างซ้าย 

 
 
 ปรับ opacity จาก 100% เป็น 40% bg_white จะจางลงจะเห็นตัวเกม 

 
 

 ต่อไปกด Add new object อีกครั้ง เพื่อเพ่ิม Sprite อีก 1 อัน เลือก import image  
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 ให้เลือกรูปภาพสำหรับ interface ที่เตรียมไว้ ชื่อว่า PastelUIFree ซึ่งดาวน์โหลดมาจากเว็บไซต์  
https://toffeecraft.itch.io/ui-user-interface-pack-pastel-dream 

     
 
 โปรแกรมจะแนะนำให้ทำเป็น Copy ไฟล์ไว้ในโฟลเดอร์โปรเจค ให้กด OK 

 
 

 จะได้หน้า Edit NewSpriteS เปลี่ยนชื่อเป็น title แล้วกด Edit with Piskel เพ่ือเข้าไปแก้ไข
รูปภาพ 

 
 

 จะข้ึนหน้า Piskel เราจะใช้แค่ป้ายที่เป็นกรอบสีฟ้าแผ่นเดียว เลือกเมนู Rectangle Selection  

 
  

https://toffeecraft.itch.io/ui-user-interface-pack-pastel-dream
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นำมาคลุมในส่วนที่ต้องการ แล้วกดท่ีเครื่องมือ Crop the Sprite ในเมนู Transform 
 

 
 
 ภาพจะถูก Crop มาแค่ส่วนที่เลือก ให้ใช้เมนู Selection เดิมเพ่ือ Crop ภาพอีกครั้ง โดยที่ให้ขอบ
ของภาพพอดีกับรูปภาพเลย  
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 เมื่อได้ภาพที่พอดีกับขอบแล้ว ให้กดเมนู Resize ที่อยู่ขอบจอด้านขวามือ ปรับค่า parameter ตาม
ภาพ แล้วกด Resize 

  
 

จากนั้นกด save กลับมาที่หน้า Edit title กด Apply แล้วลาก title มาไว้ใน Scene  
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กด Add a new Object แล้ววเพ่ิม object ที่เป็น Text  

 
 

 เปลี่ยนชื่อ object เป็น title_txt ใส่ข้อความที่เป็นชื่อเกมลงไป “RUN RUN RUN” ปรับขนาดเป็น 
40 ตามภาพ สามารถเลือกสีและปรับขนาดได้ตามต้องการ  

 
 
 ให้กด Choose a font เพ่ือเลือก font ใหม่  ถ้ามีไฟล์ font อยู่แล้ว ให้เลือก Choose a file แต่ถ้า
ไม่มี ให้เลือกจาก asset store  
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 ค้นหา font ที่ชอบ หรือพิมพ์ kenney mini เพ่ือเลือกฟ้อน kenney mini square กดท่ี font ที่
ต้องการ แล้วกด install font 

 
 

 จะกลับมาที่หน้า Edit title_txt สามารถปรับ Outline หรอื Shadow ได้ เมื่อปรับจนพอใจแล้ว กด 
Apply แล้วลาก title_txt มาไว้ใน Scene  
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 สร้าง Object Text ขึ้นมาอีก 1 อัน พิมพ์ข้อความว่า  
 Press “space” to Jump and “LControl” to Ducking 
 เพ่ือเป็นการอธิบายวิธิเล่นเบื้องต้น และนำมาไว้ใน Scene  

 
 

 จากนั้นเพิ่ม Button สำหรับการกด Play ไปที่เพ่ิม object แล้วเลือก Button 
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 เมื่อสร้างแล้ว สามารถเลือกปุ่มจาก Asset Store ที่มีให้ก็ได้ หรือจะ import ภาพใหม่เข้ามาเพ่ือ
สร้างปุ่มเองก็ได้ แนะนำให้เลือก button ที่มีอยู่แล้ว แล้วค่อยเปลี่ยนรูป เพื่อเอา setting ของ button เดิม 

 
 ให้ดับเบิลคลิดที่ button ในรายการ object เพ่ือเปิดหน้าต่าง edit  

 
 จะได้หน้าต่าง Edit button ให้ตั้งชื่อใหม่ว่า play_bt แล้วใส่ข้อความว่า PLAY เลือก font เป็น 
Kenney mini square เปลี่ยน Top padding = 20 

 
 จากนั้นเลื่อนลงมาเพ่ือ import รูปภาพของปุ่ม ซึ่งจะถูกแบ่งเป็น 3 ภาพคือ 1.idle 2.hover 
3.pressed 
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ภาพสำหรับ idle ให้กด Choose a file แลว้เลือกภาพ PastelUIFree ภาพเดิม  
 เนื่องจากมีภาพของปุ่มอยู่แล้ว ให้กด Replace แล้วเลือกภาพใหม่ทับไปได้เลย 

 
 
 เมื่อได้ภาพมาแล้วจึงทำการ Edit with Piskel 

 
 
 ใช้เครื่องมือ Selection เลือกแค่ส่วนที่ต้องการ แล้ว Crop ภาพให้พอดี  

 
 
 ใช้เครื่องมือ Color picker เพ่ือดูดสีชมพูจากในภาพ แล้วใช้ถึงสีเทลงไปในตัวหนังสือสีขาว เพื่อลบ
ตัวหนังสือออก ให้เหลือแต่ปุ่มเปล่าๆ แล้วกด Resize ปรับขนาดตามภาพ แล้วกด save  
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 แก้ไขปุ่ม hover โดยทำเช่นเดียวกันกับปุ่ม idle แต่ในขั้นตอนการใส่สี ให้เลือกสีที่เข้มกว่าเดิมนิด
หน่อย เพื่อให้เห็นว่าเมาส์กำลังวางอยู่ จากนั้นกด s แล้ว Save  
 

  
 
 แก้ไขปุ่ม Pressed โดยทำเหมือนปุ่ม hover แล้วคัดลอกโค้ดสีมาจาก Hover เพ่ือมาใส่ใน pressed  

  
 ใน Pressed จะลบส่วนที่เป็นสีแดงออก เพ่ือใหปุ่มดูเหมือนถูกกดจมลงไป เลยต้องลบออก 1 แถว 
pixel และในส่วนเงาด้านล่าง ก็วครจะถูกทำให้เป็นสีปุ่ม 1 แถว   

 
 จะดังนี้ กด Resize ให้ตรงกับขนาดของ 2 ปุ่มก่อนหน้า แล้วกด Save  
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 กลับมาหน้า Edit play_bt แล้ว กด Apply เพ่ือปิดหน้าต่าง จากนั้นลาก play_bt มาไว้ใน Scene 
ได้เลย กด Preview แล้วลองกดปุ่มเพ่ือตรวจสอบ animation ของปุ่มได้  
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11. ทำ Interface ของเกม (หน้า Run Game) 

 เมื่อได้หน้า Game Start แล้ว ต่อไปจะเป็นการสร้าง interface ในหน้าของเกมที่กำลัง Running อยู่ 
ซึ่งหน้านี้ ให้ทำเพียงแค่ใส่คะแนน และปุ่มปิดเสียง เท่านั้น  
 ให้สร้าง Layer ใหม่ในหน้า Scene ตั้งชื่อว่า ui_run แล้วลากให้มาอยู่ด้านล่างของ ui_start  

 
 

 จากนั้นสร้าง Object ใหม่ เป็น Text ตั้งชื่อว่า score ใส่ข้อความเป็นเลข 0 เลือก font Kenney 
mini square ปรับให้จัดข้อความแบบก่ึงกลาง และปรับขนาดเป็น 50 

 
  
 ให้ลาก Object มาไว้กลางจอ จะพบว่าเลข 0 อยู่หลัง Sprite สีขาวที่ทำไว้ในหน้า ui_start  
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ให้ปิดตา Layer ui_start ไปก่อน เพ่ือทำงานใน layer ui_run  

 
 

 
 

 จากนั้นเพิ่ม object ที่เป็น Toggle switch ขึ้นมา เลือกปุ่มที่อยู่ใน asset store 
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 คลิกขวาที่ object ปุ่มที่สร้างไว้ เลิก Rename ให้เปลี่ยนชือ่เป็น music_bt 

 
 

 

 ลากปุ่มมาวางไว้ที่มุมบนขวาของ Scene ขยายให้มีขนาดพอดี  

 
  
 สร้าง Sprite ใหม่เพ่ือเพ่ิมรู้ภาพลำโพง หรือสัญลักษณ์ดนตรี กด add new object แล้วเลือก Asset 
store พิมพ์ค้นหาคำว่า sound เลือก asset รูปลำโพงที่มีแอนิเมชัน กด add to scene  
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 ลากมาวางไว้ในปุ่ม music_bt ปรับขนาดให้เล็กพอดี  

 
 

12. ทำ Interface ของเกม (หน้า Game over) 

 ให้เพ่ิม layer ขึ้นมาใหม่ ชื่อว่า ui_over ลากมาอยู่ด้านล่างของ ui_start  

 
  
 ลาก bg_white มาวางไว้ที่ Scene ปรับ Opacity ให้เหลือ 50% แล้วขยายให้เต็มจอ (ทำเหมือน
ตอน ui_start) 
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 เพ่ิม Sprite สำหรับป้ายไว้เขียนว่า Game over  

 
 

 เลือก import image โดยเลือกภาพ PastelUIFree ที่เตรียมไว้ 

 
 

 เปลี่ยนชื่อเป็น over และแก้ไขรูปภาพด้วย Edit with Piskel 
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 เลือกภาพที่ต้องการ และกด Resize ปรับขนาดตามรูปภาพ แล้วกด Save 

 
 
 กด Apply เพ่ือปิดหน้าต่าง Edit จากนั้นลาก object over มาไว้ใน Scene แล้วขยายให้พอดี   

 
 
 สร้าง object Text สำหรับใส่ข้อความว่า GAME OVER ตั้งชื่อว่า over_txt เปลี่ยนขนาดและ
ตัวหนังสือเป็นสีแดง  
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 ลากออกมาวางไว้ที่ Scene และปรับให้เหมาะสม 

 
  
 สร้างปุ่มเพ่ือใส่คำว่า Restart โดยทำเช่นเดียวกับปุ่ม Play ของหน้า ui_start หรือคลิกขวาที่ object 
ของ play_bt แล้วเลือก duplicate เพ่ือ copy ปุ่ม  

 
  
 เปลี่ยนชื่อเป็น restart_bt แล้วดับเบิลคลิก เพ่ือเข้าหน้า Edit เปลี่ยนข้อความและเปลี่ยนสีของปุ่ม 
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13. ปรับขนาดของจอเกม เมื่อเปิด Full Screen  

 เมื่อกด Preview แล้วเปิดขยายเต็มจอ จะพบว่าขนาดจอของเกมไม่ขยายตาม ทำให้เห็น Object ที่
ล้นออกนอกจอ  

 
 

 ให้กดท่ีตั้งค่า มุมซ้ายบนของโปรแกรม แล้วเลือก Properties & Icons  
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 ในหน้าต่าง Game Properties ให้เลื่อนลงมาที่ Resolution and rendering ให้แก้ไขหัวข้อ Game 
resolution resize mode (Fullscreen or window) ให้เปลี่ยนเป็น No changes to the game size  

  

 กด Apply แล้วทดสอบด้วยการกด Preview แล้วเปิดเต็มหน้าจอ จะพบว่าจอไม่ล้นแล้ว 
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14 จัดการ Event สำหรับ Game State (start) 

 เมื่อได้ interface ของเกมทั้งหมดแล้ว ต่อไปต้องทำการกำหนดว่า layer ต่างๆ จะ Show หรือ hide 
ใน state ใด และต้องกดปุ่มใดเพ่ือเปลี่ยน state โดยเริ่มจาก เปิดตา Layer ทั้งหมดก่อน  

 
  
 ให้มาที่หน้า Event sheet ในส่วนของ Game start กด Add action 

 
 

 พิมพ์ค้นหาว่า layer เลือก Show a Layer เลือกเป็น ui_start 
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 กด Add action อีกครั้ง แล้วเลือกเป็น Hide a layer เลือกเป็น ui_over 

 
 

 จะได้ Event ดังนี้ เป็นการตั้งค่าให้แสดงหน้า Start และซ่อนหน้า Game over ไว้ ตอนเปิดเกม
ขึ้นมา  

 
 

 ต่อไปทำการเพ่ิม sub event ด้วยการคลิกขวาที่ Group event > Add > Sub Event  
 เพ่ือกำหนดเงื่อนไข ของการกดปุ่มเริ่มเกม
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 เพ่ิมเงื่อนไขของการกดปุ่ม play_bt ให้เลือกที่ปุ่ม play_bt > Is pressed แล้วกด Apply  

 
  

 ให้กด Add action เพ่ือเปลี่ยนค่าตัวแปร GameState = “run” เมื่อกดปุ่ม play_bt แล้ว  

 
 
 ค้นหา Change variable value > GameState = “run” 

 

 จะได้ Event ของ Game start ดังนี้ 
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 หากกด Preview จะพบว่า เมื่อกดปุ่ม Play แล้ว ฉากจะไหล แล้วสามารถเล่นเกมได้ แต่ Layer 
Start จะยังไมห่ายไป ต้องไปตั้งค่าท่ีส่วนของ Game running  ก่อน  
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15 จัดการ Event สำหรับ Game State (running) 

 ในส่วนของ Game running ต้องตั้งค่าให้ Hide a Layer ui_start และ ui_over เพ่ือให้สามารถเล่น
เกมได้ และทำให้มีการเริ่มนับคะแนน โดยทำได้ดังนี้  
 มาท่ีเงื่อนไขของ GameState = “run” ที่ทำไว้ตั้งแต่แรก ให้กด Add action  

 
 
 เพ่ิม Hide a Layer ui_start และ Hide a Layer ui_over หน้า ui จะหายไปเมื่อกด play  

 
 
 ต่อไปจะทำการสร้างระบบคะแนน ให้สร้างตัวแปร ชื่อว่า score สำหรับเก็บคะแนน โดยกดเมนู 
properties    ที่มุมบนซ้ายของโปรแกรม คลิกขวาที่ Game > Edit scene variable  
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 กด Add variable แล้วตั้งชื่อว่า Score ชนิด Number ใสค่่าเริ่มต้นเป็น 0 กด Apply เพ่ือปิด
หน้าต่าง  

 
 

 จะตั้งเง่ือนไขว่า ทุกๆ 0.5 วินาที คะแนนจะเพ่ิมขึ้น 1 คะแนน สร้าง Sub event ใต้ Game running 
ดังนี้  
 คลิกขวาที่ เงื่อนไขของ GameState = run แล้วเลือก Add > Sub Event  

 
 

 จะได้ Event ใหม่ อยู่ด้านล่างของ Scene Scrolling ให้ลากข้ึนมาอยู่ข้างบน  
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วันทีอ่บรม : 26-27 มนีาคม 2568 

 ให้กดท่ี Add condition เลือก Other conditions  
 เลือก Repeat every X seconds > Repeat with a scene timer  
 ตั้งชื่อเป็น “score” และตั้งเวลาเป็น 0.5 วินาที 

 
 
 กด Add action เพ่ือให้ score add 1  

 
 
 ค้นหา change variables value เลือกตัวแปรเป็น Score + 1  

 
 
 จะได้ดังนี้ ให้กด add action ใน Event ของ GameState = run เพ่ือให้ object score นำค่าในตัว
แปร Score มาแสดง  
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 เลือก score ที่เป็น Object text แล้วเลือก Text จากนั้นให้ใส่ = Score  
 **ระวังเกิดความสับสนเนื่องจากชื่อตัวแปร Score และชื่อ Object score มีความเหมือนกัน แต่
ความจริงแล้ว ชื่อตัวแปร ขึ้นต้นด้วยตัวพิมพ์ใหญ่ และชื่อ object เป็นตัวพิมพ์เล็กทั้งหมด ดังนั้นกรณีตัวอย่าง
นี้ อาจจะยกตัวอย่างได้ไม่ดีนัก ควรจะตั้งชื่อให้มีความแตกต่าง และมีความชัดเจน เช่น ชื่อ object ควรจะเป็น 
score_txt เป็นต้น  

 
  
 เมื่อเสร็จแล้วจะได้ดังนี้  

 
  
 กด Preview จะพบว่าคะแนนเริ่มนับไปเรื่อยๆ ตอนกด play 
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16 จัดการ Event สำหรับ Game State (over) 

 ในเงื่อนไขของ Game Over จะทำเหมือนหน้า Start คือเมื่อ GameState = “over” จะทำการ 
Hide a Layer ui_start แล้ว Show a Layer ui_over แทน  
 เมื่อกดปุ่ม Restart แล้ว จะให้ Scene กลับไปเริ่มต้นใหม่ โดยใช้ Change the Scene Game และ
เปลี่ยนค่า GameState ให้กลบัไปเป็น “start” เหมือนเดิม ทำได้ดังนี้  
 เพิ่ม Action ของการ Hide และ Show Layer ขึ้นมา (กลับไปดูวิธีทำในหัวข้อ 14 จัดการ Event 
สำหรับ Game State (start) ) 

 
 คลิกขวาที ่Event GameState = “over” เพ่ือเพ่ิม Sub Event 

 
 เพ่ิม condition และ action สำหรับการกดปุ่ม restart_bt แล้ว GameState = “start” 
(กลับไปดูวิธีทำในหัวข้อ 14 จัดการ Event สำหรับ Game State (start) ) 
 เมื่อเสร็จแล้วให้กด Add action เพ่ือเพ่ิมการเปลี่ยน Scene  

 
 

 เลือก Other action > Scene > Change the scene แล้วเลือก Game กด OK  

 
 
 จะได้ดังนี้ 
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 ปัจจุบันยังไม่สามารถทดสอบ หน้า Game over ได้ เนื่องจากยังไม่ได้สร้างเงื่อนไขของการทำให้ตัว
ละครตาย ดังนั้นจะละไว้ แล้วไปสร้างระบบอ่ืนก่อน  
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17. Spawn Enemy เพิ่มระบบ Monster   

 ในรูปแบบของเกม Endless Runner จะมี Monster หรือ Danger สุ่มเกิดเพ่ือให้ผู้เล่นต้องกระโดด 
หรือหมอบเพ่ือหลบ และเมื่อชนจะตายและ Game over  
 ในเกมนี้ จะใช้ Monster ที่เดินบนพื้น 3 ตัว และ Monster ที่บินอยู่บนฟ้า 2 ตัว โดยจะให้สุ่มเวลา
เกิด ทุกๆ 0.8 – 2 วินาที และเกิดสลับกัน โดยจะกำหนดเงื่อนไข ดังนี้  
 1. การเกิด monster แต่ละตัว จะสุ่มเกิด โดยสุ่มตัวเลข 1-5  
    - หากเป็นเลข 1 จะให้ monster ตัวที่ 1 เกิด 
    - หากเป็นเลข 2 จะให้ monster ตัวที่ 2 เกิด เป็นต้น  
 2. ความถี่ในการเกิดของ monster จะถูกสุ่มตั้งแต่ 0.8 – 2 วินาที  
 3. ความเร็วในการเดินของ monster เริ่มต้นที่ 3 และจะเร็วขึ้น เมื่อเวลาผ่านไป  
     สามารถทำให้ monster เคลื่อนที่ได้ โดยการเปลี่ยนตำแหน่ง X ของ monster เช่นเดียวกับตอน
ที่ทำ platform  
  
 จากเงื่อนไขที่ตั้งไว้ สามารถทำได้ โดยมีขั้นตอนดังนี้   
 1. เพิ่ม Object Sprite  สำหรับเป็นจุด spawn monster ตั้งชื่อว่า spawn_point 
 2. เพิ่ม Object Monster 1,2,3,4,5 โดยเลือกจาก Asset store  
 3. ปรับแต่งขนาด และตำแหน่ง Collision และ Points ของ Monster  
 4. สร้างตัวแปรของ Scene ดังนี้  
    4.1 mons_ran สำหรับเกบ็ตัวเลขของการสุ่ม monster แต่ละตัว  = 99 
    4.2 mons_speed สำหรบัเก็บค่าความเร็วของการเดินของ monster = 3 
    4.3 spawn_rate สำหรับเก็บค่าเวลาที่จะ spawn monster =1 
  5. ทุกๆ 0.8-2 วินาที จะสุ่ม mons_ran  และสุ่ม spawn_rate ใหม่ 
 6. สร้างเงื่อนไขการเกิด monster แต่ละตัว จาก mons_ran ที่สุ่มได้ โดยให้ monster เกิดท่ี
ตำแหน่งของ spawn_point และในแต่ละเงื่อนไข จะเกิดแค่ครั้งเดียว (trigger once) 
 7. ทำให้ monster เคลื่อนที่ โดยการลบตำแหน่ง X ของ monster  
 8. ทุกๆ 10 วินาที ให้ mons_speed เพ่ิมข้ึนทีละ 2 
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เมื่อวางแผนเรียบร้อย จึงเริ่มทำทำในโปรแกรม ตามขั้นตอนที่เขียนไว้ ดังนี้  
 1. เพ่ิม Object Sprite  สำหรับเป็นจุด spawn monster ตั้งชื่อว่า spawn_point  
 ใน Base Layer กด Add a new Object  

 
 

 เลือก Sprite   
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ตั้งชื่อเป็น spawn_point แล้วกด Create with Piskel เพ่ือใช้เป็นจุดสำหรับการ spawn monster 

 

 เทสีดำลงไป แล้วกด save  

 

กด Edit point เพ่ือปรับจุด Origin ของ spawn_point ให้อยู่มุมซ้ายล่างสุด เพ่ือเป็นจุดให้ monster เกิด  

 
  



118 

เอกสารประกอบการอบรม หลักสูตร “No-Code Game Camp: สร้างเกมสุดมันส์ ไม่ต้องเขียนโค้ด” 
แผนกวิชาเทคนิคคอมพวิเตอร์ สาขาคอมพวิเตอร์เกมและแอนเิมชนั วทิยาลัยเทคนิคจนัทบุรี 
วันทีอ่บรม : 26-27 มนีาคม 2568 

 ปรับจุด Origin ให้เป็น X = 0, Y = 64 กด Apply เพ่ือปิดหน้าต่าง edit spawn_point  

 
 

 ลาก spawn_point ออกมาวางไว้บน platform นอก Scene เพ่ือไม่ให้แสดงในจอ แต่ต้องวางให้พ้ืน
ชิดกับ platform เพื่อเวลาที่ monster เกิด จะได้ไม่ลอย เพราะตำแหน่งที่ monster จะเกิด จะอ้างอิง
ตำแหน่งมุมซ้ายล่างของ spawn_point 
 

 
 

 2. เพ่ิม Object Monster 1,2,3,4,5 โดยเลือกจาก Asset store  
     เพ่ิม Object ของ monster ให้กด Add new object แล้วเลือกที่ Asset Store เพ่ือใช้ Asset ที่
มีอยู่แล้ว พิมพ์ค้นหา Grafxkid  
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 เลือก monster ตัวใดก็ได้ 3 ตัวเป็นตัวที่เดินบนพื้น และ 2 ตัวเป็นตัวที่บินได้  
 กด Add to the Scene แล้วกดย้อนกลับ เพื่อไปเลือกตัวอ่ืน 

 

  
 เมื่อเลือกเสร็จแล้ว จะขึ้นอยู่ที่เมนู object ให้เปลี่ยนชื่อ monster ที่เลือกมาแล้วให้เป็น mons1 , 
mons2 , mons3 fly_mons4, fly_mons5 เพื่อให้ง่ายต่อการทำงาน โดยให้ fly_mons4,5  คือ monster 
ที่บินได้ โดยการคลิกขวาที่ object แล้วกด rename  

 
 ลองลาก monster ออกมาวางใน scene จะพบว่า monster ตัวเล็กมาก และไม่สามารถใช้วิธีการ
ขยายเหมือนตัว player ได้ เพราะจะใช้คำสั่งในการ Create ให้เกิด object ขึ้นมา จึงต้องปรับขนาดของ 
monster แต่ละตัวก่อน ให้ดับเบิลคลิกท่ี monster เพ่ือเปิดหน้า Edit  
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 จากนั้นลบแอนิเมชันที่ไม่ใช้งานออก ให้เหลือเพียงแอนิเมชันเดียว คือ walking หรือ running หรือ
แอนิเมชันที่ต้องการให้ monster แสดงตอนเคลื่อนไหว  

 
 

 
 

 ในแอนิเมชันที่เลือก ให้กด Edit with Piskel เพ่ือปรับขนาด  
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 เลือกเมนู Resize แล้วปรับ Hight ให้เป็น 70 (สามารถปรับเป็นค่าอ่ืนได้ตามต้องการ) แล้วค่าอ่ืนจะ
ปรับตาม กด Resize และกด save เพ่ือบันทึก 

   
 

  เมื่อปรับขนาดแล้ว ให้มากดที่ Edit collision เพ่ือปรับตำแหน่ง collision หาก monster ที่เลือกมา
ไม่จำเป็นต้องปรับ collision มาก ก็สามารถปิดได้เลย แต่หาก monster ที่รูปร่างไม่คล้ายกับสี่เหลี่ยม อาจจะ
ต้องปรับ collision เพราะให้เหมาะสมก่อน โดยใช้วิธีเดียวกันกับตอนปรับ Collision ของ Player (กลับไปดู
หัวข้อ 3 ได้) 

 
 

 เมื่อปรับ collision แล้ว ให้มาปรับ Points ด้วย เพราะตัว points ของ monster จะใช้เป็นจุดที่ระบุ
ตำแหน่งการเกิดของ monster ซึ่งจะปรับตำแหน่ง origin ให้อยู่ตรงกลาง ล่างสุด ตามภาพ  
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 จากนั้นให้ edit point ของ monster  

 
 

 เลือก point ชื่อ Qrigin ปรับให้อยู่ตำแหน่งกลางภาพ และล่างสุด แล้วกด Apply ใช้สำหรับการ
กำหนดตำแหน่งที่ monster จะเกิด ให้ตรงกับจุด origin ของ spawn_point ซ่ึง  

 
  
 ให้ปรับแบบเดียวกัน ใน monster ทุกตัว  
 
 จากนั้น เปิดเมนู properties ของ game เพ่ือสร้างตัวแปรใน scene  
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 กด Add variables แล้วสร้างตัวแปร 3 ตัว ดังนี้  
 mons_ran = 99 , mons_speed = 3 , spawn_rate =1 
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18. สร้าง Event สำหรับการ Spawn Monster  

 Event ของการ Spawn Monster จะทำงานใน Game Running เพราะ มอนเตอร์จะเกิดในขณะที่
เกมกำลัง running อยู ่ ดังนั ้น ให้มาที Group Event ของ Game running คลิกขวาที่เง ื ่อนไขของ 
GameState = “run” แล้วเลือก Add > Event Group   

 
 
 จะมี event ใหม่ เกิดขึ้นด้านบนของ Event หลัก ให้คลิกค้าง เพื่อลากย้ายลงมาอยู่ด้านล่างของ 
Scene Scrolling ตั้งชื่อ Group Event ว่า Spawn Monster  
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 ให้คลิกขวาที่ Group Event Spawn Monster แล้วเลือก Add > Sub Event จะเกิด Event ใหม่
ขึ้นมา  
 ให้กดท่ี Add condition เลือก Other conditions  

 
 

 
 

 เลือก Repeat every X seconds > Repeat with a scene timer  
 ตั้งชื่อเป็น “spawn” และตั้งเวลาเป็น spawn_rate วินาที (จะใช้ค่าใน spawn_rate) 
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 จากนั้น Add action เลือก Change Variable Values กำหนดให้ตัวแปร  
 mons_ran = RandomInRange(1,5) กด ok  

 
  
 และ Add action อีกครั้ง ในเงื่อนไขเดิม เลือก Change Variable Values กำหนดให้ตัวแปร 
spawn_rate = RandomFloatInRange(0.8,2) กด OK  

 
 

 
  
 ให้คลิกขวาที่เงื่อนไข Repeat every spawn_rate แล้วกด  Add > Sub Event  

 
 

 จากนั้นสร้างเงื่อนไขของการเกิด monster ดังนี้  
 กด Add condition > variable monster_ran = 1  

 
 

 
  



127 

เอกสารประกอบการอบรม หลักสูตร “No-Code Game Camp: สร้างเกมสุดมันส์ ไม่ต้องเขียนโค้ด” 
แผนกวิชาเทคนิคคอมพวิเตอร์ สาขาคอมพวิเตอร์เกมและแอนเิมชนั วทิยาลัยเทคนิคจนัทบุรี 
วันทีอ่บรม : 26-27 มนีาคม 2568 

 และ add condition อีกครั้ง ค้นหา Trigger เพ่ือเลือก Trigger Once  

 
 

 จะได้ดังนี้  

 
 

 เมื่อสร้าง 2 เงื่อนไขเสร็จแล้ว ให้กด Add action 
 เลือก mons1 > Create an Object  
 กำหนด X position = spawn_point.PointX(“Origin”) คือ ตำแหน่ง X ของ origin 
spawn_point  
 กำหนด Y position = spawn_point. PointY(“Origin”) คือ ตำแหน่ง Y ของ origin 
spawn_point  
 สร้างข้ึนที่ Layer Base แล้วกด OK  
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 เมื่อ Create Object แล้ว ใหท้ำการ Flip Object เนื่องจาก monster ที่ สร้างขึ้นมานั้นหันหน้าไป
ทางขวา ซึ่งคนละทางกับที่ควรจะเดิน จึงต้องทำการ flip เพ่ือให้หันกลับไปหา Player ดังนี้  
 กด Add action ใต้ action ล่าสุด เลือก mons1> Flip the object Horizontally เลอืก Activate 
Yes 

 
 จะได้ดังนี้  

   

 ให้ทำการ Copy Event แล้ววาง จากนั้นแก้ไขค่า mons_ran และ ชื่อ Object ของ monster ที่
ต้องการให้เกิด จนครบ 5 ตัว  
 โดย mons1,2,3 จะใช้ค่า X,Y เหมือนกัน 

 
  
 แต่ flymons4,5 จะใช้แค่ค่า X ส่วนค่า Y จะเปลี่ยนเป็น RandomInRange(300,530) จะได้ดังนี้  
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 เมื่อเสร็จแล้ว ให้สร้าง Event ใหม่ โดยไม่อยู่ใต้ Sub event แล้ว ให้คลิกขวาที่ Event Repeat 
every spawn_rate second  แล้วเลือก Add > New Event Below  

 
 
 Event นี้ไม่ต้องใส่ Condition ให้ Add action อย่างเดียว โดยเลือกท่ี mons1 > X position แล้ว
กำหนดให้เป็น –(subtract) mons_speed 

 

 
 

 
 

 ทำซ้ำกับ monster ทุกตัว โดย Copy และ Past แล้วเปลี่ยนชื่อ Object monster  
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 สุดท้ายจะเป็นการเพ่ิมความเร็วของ monster เมื่อเวลาผ่านไปทุกๆ 10 วินาที ให้สร้าง event ใหม่ 
โดยคลิกขวาที่ Event ล่าสุด เลือก Add > New event below  

 
 กด Add condition > เลือก Other conditions  
 เลือก Repeat every X seconds > Repeat with a scene timer  
 ตั้งชื่อเป็น “speed_up” และตั้งเวลาเป็น 10 วินาที  

 
 

 
 

 จากนั้นกด Add action > Change Variables value  กำหนดให้ตัวแปร mons_speed +2 

 
 

 จะได้ดังนี้  
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 เมื่อกด Preview จะพบว่า monster มีการสุ่มเกิด ในตำแหน่งต่างๆ  และเดินเร็วขึ้นเมื่อเวลาผ่านไป 
เรียบร้อยแล้ว 
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19. Die and Over  

 ตัวละครตายเมื่อมีการชนกับ monster ตัว Player จะเปลี่ยนแอนิเมชันเป็น Hurt และค่า 
GameState จะถูกเปลี่ยนเป็น over  
 ไปที่หน้า Scene แล้วกดเปิดเมนู Group Object ให้กด Add a new group เพ่ือนำเอา monster 
ทุกตัวมาไว้ใน group เดียวกัน  

 
 

 ตั้งชื่อว่า group_monster และเลือก monster ทุกตัวมาเป็นสมาชิกใน group  
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  ไปที่หน้า Event Sheet สร้าง Group Event ใหม่ภายใต้ Game Running เปลี่ยนชื่อเป็น Dead 
and Over  

 
 

 คลิกขวาที่ Group Dead and Over แล้วเลือก Add > Sub Event 

 
 

 สร้างเงื่อนไขว่า หาก Player ชนกับ group_monster   

 
 กด Add condition เลือก player > collision > group_monster 
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 ในเงื่อนไขนี้ จะให้เจอแค่ครั้งเดียว จึงใส่ Trigger once ไว้ด้วย  

 
 

 
 
 ให้ทำการเปลี่ยนแอนิเมชันของ Player เป็น Hurt  
 กด Add action เลือก Player > Change Animation Player to Hurt 

 
 
 และเปลี่ยน GameState เป็น over  
 กด Add action เลือก Change variable value > GameState = “over” 
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 จะได้ดังนี้  

 
 
 กด Preview แล้วลงให้ Player ชนกับ monster เกมจะหยุดลง แล้วจะข้ึนหน้า Game over  
  

 
 
 เมื่อกด restart จะกลับมาหน้าเริ่มต้นของเกมใหม่ เป็นอันเสร็จสิ้น  
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Event Sheet ปัจจุบัน 
 ภาพรวม 

 
 
 Control Player และ Double jump 
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 Scene Scrolling 

  
 
 Spawn monster และ Dead and Over  
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20. Add Music And Sound  

 การควบคุมเสียงดนตรี จะไม่เกี่ยวข้องกับ Game State จึงไม่มีการสร้าง Event ภายใต้ Game 
State ใดๆ แต่จะสร้าง Group ใหม่ ที่อยู่ในระดับเดียวกันกับ Game State ทั้ง 3 Group  
 ให้คลิกขวาที่ Add a new Event ด้านล่างสุด จากนั้นเลือก Event Group ตั้งชื่อว่า Sound And 
Music  

 
 คลิกขวาที่ Group แล้วกด Add > Sub Event  

 
 ให้กด Add condition แล้วเพ่ิม At beginning of the scene  
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 กด Add action และทำดังนี้  
 1. ค้นหาคำว่า music  
 2. เลือก Play a music file on a channel  
 3. กด Choose a file แล้วเลอืก Choose from asset store เพ่ือเลือกเสียงเพลง    

 
  
 พิมพ์ค้นหาคำว่า piano จากนั้นเลือกเพลง The Celebrated Minuet for piano กด Add to 
project 
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 4. ใส่ channel identifier = 1  
 5. กด Yes ที่ repeat the sound  
 6. ใส่ Volume  = 30   

 
 

 เพลงจะดังทันทีเมื่อเปิดเกม ให้ปรับระดับเสียงดนตรีตามความเหมาะสม  
 จากนั้นให้ใส่เสียงตอนกระโดด และเสียงตอนชน monster ด้วยวิธีเดียวกัน โดนเลือกใช้ไฟล์เสียงที่
เตรียมไว้ แต่ให้ใส่คนละที่ ดังนี้  
 ไปที่ Group ของ Double Jump ให้เพ่ิม Action ของการเล่นเสียง Jump ใน Event แรก ดังนี้  

 
  
กด Choose a file แล้วเลือกจาก Asset store   
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 เลือกเสียง Jump 4 จาก Asset Store  

 
 

 ใส่ channel identifier = 2 เพราะต้องการให้เสียงแยกอกจากเสียง background 
 กด No ที่ repeat the sound เพราะให้ดังแค่ครั้งเดียว ไม่วนลูป และใส่ Volume  = 30  

 
 

 ได้ดังนี้ 
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 เพ่ิม Action ของการเล่นเสียง dead ในเงื่อนไขตอนที่ตัวละครชนกับ monster ให้มาที Dead and 
Over กด Add action โดยไม่ต้องสร้าง event ใหม่  

  
 
 ในการเลือกเสียง game over ให้เลือกจากไฟล์ที่เตรียมไว้ให้ในเครื่อง เนื่องจาก ในasset store ไม่มี
เสียงที่เหมาะสม กด Choose a file เลือกไฟล์เสียง .mp3 ชื่อ Game-over-arcade.mp3 

 

 
 

 ซึ่งไฟล์เสียงนี้ดาวน์โหลดมาจากเว็บไซต์ pixabay.com สามารถดาวน์โหลดมาใช้ได้ฟรี แต่ควร
ตรวจสอบลิขสิทธิ์ก่อนนำไปใช้ในเชิงพานิชย์ 
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 เสร็จแล้วจะได้ดังนี้  

 
 
 เมื่อเพ่ิมเสียงเรียบร้อยแล้ว จะตั้งค่าปุ่มเปิด/ปิดเสียง เพ่ือให้สามารถปิดเสียงดนตรีได้ โดยให้ทำการพ
เม Event ที่ Group Sound and Music ดังนี้  
 คลิกขวาที่ Event ใน Sound and Music แล้วเลือก Add new event below  

 
 

 กด Add condition ของการกดปุ่ม ให้เลือก music_bt แล้วเลือก is checked  
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 2. Add action Resume playing a music on a channel ใส่ channel 1 

 
 

 
 
3. Add action SoundButton Change Animation to ON    
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 เพ่ิมเงื่อนไขของการกดปิดเสียง โดยทำเช่นเดียวกันกับการเปิดเสียง แต่ใช้ invert condition  
 เพ่ิม Event ขึ้นมาใหม่  

 
 

 1. Add condition ของการกดปุ่ม ให้เลือก music_bt แล้วเลือก is checked แล้วกดปุ่ม invert 
condition 

 
 

 2. Add action Pause the music on a channel ใส่ channel 1 
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 3. Add action SoundButton Change Animation to OFF  

 
 

 
 
 ทดสอบโดยการกด Preview จะพบว่ามีเสียงดนตรีแล้ว เมื่อกระโดดจะได้ยินเสียง jump และเม่ือชน
กับ monster จะมีเสียง Game over โดยสามารถกดเปิด/ปิดเสียงดนตรีได้ที่ปุ่ม music_bt แต่ยังคงได้ยิน
เสียงกระโดนอยู่ เพราะ เลือก Pause แค่ Channel 1 แต่ เสียง Jump และ over อยู่ channel 2 
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21. สร้าง UI สำหรับการเล่นในโทรศัพท์  

 เกมปัจจุบันที่ทำเสร็จแล้ว จะสามารถเล่นได้บนคอมพิวเตอร์เท่านั้น เนื่องจากต้องกด Space bar 
และ Left Control เพื่อควบคุมตัวละคร จึงไม่สามารถเล่นในโทรศัพท์ได้ เพราะไม่มีคีย์บอร์ด ดังนั้นจึงต้อง
สร้างปุ่มกด สำหรับกรณีที่เล่นในโทรศัพท์ ซึ่งทำได้ดังนี้  
 1. ให้กด Add a new object เพ่ือสร้างปุ่มขึ้นมา 2 ปุ่ม  

 
 
 กดเพ่ิมปุ่มสีเหลือง และสีเขียว  

 
 

 ให้เปลี่ยนชื่อปุ่มเป็น jump_bt และ ducking_bt 
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 สร้าง Layer ใหม่ ตั้งชื่อว่า mobile_layer ลากให้มาอยู่ด้านล่าง layer ui_over  

 

จากนั้นลากปุ่มมาวางบน Scene  
 

ดับเบิลคลิกท่ีปุ่ม เพื่อเข้าไปแก้ไขข้อความและ font  
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 มาท่ี Event Sheet เริ่มจาก Game start ให้แสดง mobile_layer หากตรวจพบว่าอุปกรณ์ที่เปิด
เกมเป็น Mobile device ดังนี้  
 คลิกขวาที่ event GameState = “start” แล้วกด Add sub event  

 
 กด Add condition ค้นหา mobile  

 
 เลือก Is a mobile device แล้วกด OK  
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 กด Add action > Show a Layer > mobile_layer กด OK  

 
 

 
 

 ให้สร้าง event ใหม่อีก 1 event แล้ว Add condition > Is a mobile device เลือก invert 
condition 

 
 

 กด Add action > Hide a Layer > mobile_layer กด OK จะได้ดังนี้ 
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 ต่อไปเป็นการสร้างเงื่อนไขเม่ือกดปุ่ม jump_bt ให้กระโดด เมื่อกด ducking_bt ให้หมอบ เหมือน
ตอนกดคีย์บอร์ด ดังนั้นต้องไปที่เงื่อนไขที่มีการกำหนด key space และ key Lcontrol โดยเริ่มจาก  
 1. ใน Control Player กด Add condition ที่ Event ของ การกด Space 

 
 2. ค้นหาเงื่อนไข or แล้วกด ok  

 
 จะได้  
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 3. ให้ย้ายเงื่อนไข Space key is pressed เข้ามาไว้ใน sub-condition 

 
 4. กด Add sub-condition > เลือกปุ่ม jump_bt > Is pressed กด OK 

 
 

 จะได้ดังนี้ 

 
 

 ทำเช่นเดียวกันกับ เงื่อนไข LControl key is pressed ใน Control player 
 ให้สังเกตว่า เงื ่อนไขที ่เป็น invert condition ของ player is jumping ไม่ได้อยู ่ใน sub-
condition ของ OR 
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  สุดท้าย ใน Double Jump จะเห็นว่ามีเงื่อนไข OR อยู่แล้ว แต่ไม่สามารถใช้ร่วมกันได้ ให้กด Add 
condition แล้วค้นหา or เพ่ือ Add เข้ามาใหม ่

 
 จะได้ดังนี้  

 
 ให้ย้าย Space key is pressed เข้าไปเป็น sub-condition แล้วกด Add sub-condition เพ่ือเพ่ิม
ปุ่ม jump 
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 จะได้ดังนี้  

 
 

 หากกด preview ดู จะไม่เห็นปุ่มสำหรับโทรศัพท์ จึงยังทดสอบไม่ได้ ให้อัพโหลดเกมข้ึน website 
ก่อนจึงจะสามารถทดสอบได้  
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22. Export Game and Done!!!  

 เมื่อสร้างเกมเสร็จเรียบร้อยแล้ว สามารถ Save Project และ Export ออกมาเพื่อเล่นได้ในหลาย
แพลตฟอร์ม เช่น Web Browser , Desktop, Android และ IOS และยังสามารถเล่นบนเว็บไซต์ gd.game ได้
ด้วย โดยมีวิธีดังนี้  
 1. Save project ได้ทั้งบนเครื่องคอมพิวเตอร์ และบน Cloud ในกรณีที่มีการ Login  

 กดท่ีเมนู    Game properties มุมบนซ้ายของโปรแกรม เลือก File > Save as  

  
 

 จะข้ึนให้เลือกว่าจะบันทึกลงไปในที่ใด ให้เลือก Your Computer เพ่ือบันทึกลงเครื่อง  

 
 

 ตั้งชื่อ แล้วเลือก Start a new game from this project กด continue  
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 จะให้เลือกท่ีสำหรับบันทึกโปรเจค กด save  

 
 

 จากนั้นกดท่ี File อีกครั้ง เลือก Export  
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 ในเมนูของการ Export จะมีรายการให้เลือกว่าจะ Export ไปที่ใด โดยวิธีที่ง่ายที่สุดคือการ Export 
ไปที่ gd.games เกมจะถูกอัพโหลดขึ้น server ของ GDevelop5 และสามารถเล่น online ได้เลย  

 

 1. วิธีอัพขึ้น gd.game เมื่อเลือกแล้ว ให้กด Publish game โปรแกรมจะทำการ upload ให้รอสักครู่  
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 เมื่อเสร็จแล้วจะข้ึนหน้า Share you game  มี QR code และ url ให้เข้าเล่นเกม  

 
 

 สามารถกด url แล้วเล่นได้เลย 

 

 หากใช้โทรศัพท์แสกน QR Code เพ่ือเล่น จะเห็นปุ่ม jump และ ducking ที่สร้างไว้  
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 2. อัพขึ้น Website ของตัวเอง กรณีท่ีมี Host อยู่แล้ว ให้เลือก Browser  

 
 

 จากนั้นเลือก HTML5 

 
 

 ให้เลือกที่เก็บ Folder ของตัวเกม เพื่อที่จะนำ Folder นี้ โยนเข้าไปที่ Server  
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 จากนั้นกด Export as a HTML5 game  

 

เมื่อ export เสร็จแล้ว จะขึ้นให้กด open folder ได้  

 
จะพบ folder ที่มี asset ต่างๆ ที่เคยลงไว้ แล้วถูกเรียกใช้ในตัวเกม 
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 Folder ของเกมที่จะใช้ในการอัพโหลดขึ้น Server เปลี่ยนชื่อโฟลเดอร์ให้พิมพ์ง่ายขึ้นเมื่อพิมพ์บน url  

 

 ใช้โปรแกรม file transfer เพ่ืออัพโหลด (ซึ่งในส่วนนี้ควรมีความรู้ด้าน Server เบื้องต้นมาบ้างแล้วจึง
จะขอข้ามไป) 
 โดยเมื่ออัพขึ้น server เสร็จเรียบร้อยแล้ว จะสามารถเล่นได้เหมือนตอนอัพขึ้น gd.game เพียงแต่อยู่
ในเว็บไซต์ของตัวเอง และไม่มีโฆษณา  
 https://techniccom.technicchan.ac.th/runbytechcom/ 

 
 
 3. Export เป็นตัวเกมสำหรับเล่นบน Desktop PC  

 
 

https://techniccom.technicchan.ac.th/runbytechcom/
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 ในการติดตั้งแบบ Desktop มี 2 วิธีคือ แบบ one-click packaging และแบบ manual build  ซึ่ง
การทำแบบ manual ต้องใช้ third-party เพื่อสร้าง package ของเกม จึงจะไม่ขอพูดถึง และใช้แบบ one-
click packaging ที่โปรแกรมมีให้เท่านั้น  

 
 ซึ่งการทำแบบ one-click packaging จะได้ตัวเกมที่เป็น .exe มาเล่นได้เลย แต่จะ export ได้วันละ 
1 ครั้งเท่านั้น ให้เลือก windows (zip file) แล้วกด Create installation file  

 
 

 โปรแกรมจะทำขั้นตอน build ให้ อาจใช้เวลา 5-10 นาที 

 
  



163 

เอกสารประกอบการอบรม หลักสูตร “No-Code Game Camp: สร้างเกมสุดมันส์ ไม่ต้องเขียนโค้ด” 
แผนกวิชาเทคนิคคอมพวิเตอร์ สาขาคอมพวิเตอร์เกมและแอนเิมชนั วทิยาลัยเทคนิคจนัทบุรี 
วันทีอ่บรม : 26-27 มนีาคม 2568 

 เมื่อเสร็จแล้วจะให้กดดาวน์โหลด  

 
 

 จะได้เป็นไฟล์ Zip ให้ Extract ไฟล์ไว้ในโฟลเดอร์  

 
 

 เมื่อได้มาแล้ว จะได้หน้าตาเกม ที่เป็น icon ของ GDevelop 5 เนื่องจากไม่ได้กำหนด icon ไว้ 
สามารถ import icon ของเกมได้ในเมนู Game properties & icon ซึ่งควรจะทำก่อน export  
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 4. Export เป็นไฟล์ .apk เพ่ือติดตั้งใน android 

 

 
 มีตัวเลือกให้เหมือน Desktop และ Export ได้วันละ 1 ครั้ง เช่นเดียวกัน  

 
 

 เลือกเป็น APK แล้วกด Create package for android จะได้เป็นไฟล์ APK ให้ดาวน์โหลด 
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5. การ Export เพ่ือเล่นใน IOS ไม่สามารถทำได้ในเวอร์ชันฟรี และต้อง Publish ขึ้น App Store เท่านั้น จึง
ไม่ขอพูดถึง  

 
 
 
 
 
 
s 
 
 
 

--- THANK YOU ---  
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ผู้พัฒนา Asset และ Sound  
https://grafxkid.itch.io/ 
https://pixabay.com/users/freesound_community-46691455/ 
https://toffeecraft.itch.io/ui-user-interface-pack-pastel-dream 
 
VDO สำหรับศึกษาเพ่ิมเติม 
How to Make an Endless Runner Game in Gdevelop :  

https://www.youtube.com/watch?v=qoah3jArKJU 
Gdevelop Tutorial | Easy Scrolling Background :   

https://www.youtube.com/watch?v=r3ex2qsAaI4 
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